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ABSTRACT

LITE is a software package developed to provide both instantaneous (hourly
average) and seasonal estimates of photosynthetic photon flux density beneath
tree canopies. The model provides utilities for estimating the leaf area
contained in each cubic metre of canopy space from either a grid of directional
LAI-2000 Plant Canopy Analyzer (PCA) measurements or from tree list data
(including stem location, lean, height, height to crown base, crown extent,
diameter at breast height, leaf area (if available)). Directional PCA
measurements are taken using view restrictors supplied with the instrument
(a common approach is to take a reading in each of 4 cardinal directions using
a 90°view restrictor). When using PCA data, the user provides information
on the location of each grid point (x and y coordinates) and the height to the
top and the base of the canopy.
The model calculates the location of the sun, partitions open sky total PPFD
into diffuse and direct components, and estimates the penetration of each
through the canopy to the selected point of interest. Direct PPFD is assumed
to come from the location of the sun, diffuse PPFD is assumed to be evenly
distributed across 480 segments of the sky.
The software provides maps of LAI and PPFD across the study site and
provides information on the light regime at selected locations. Routines for
entering, merging, and editing data are also provided. The model is written
for use with MS-Windows .
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1 INTRODUCTION

The density and arrangement of overtopping trees influences the amount of
light reaching trees in the understory. On productive mixedwood sites, light
reduction by overtopping broadleaves is the primary way in which broadleaves
influence the performance of understory conifers. Successful design of
mixedwood management regimes requires an understanding of the effects
of broadleaf density and arrangement on understory light and on growth of
understory conifers. In addition, information on responses of both the conifer
and broadleaf components of mixed stands to silvicultural treatments is
required. Although instrumentation exists for making measurements of light
conditions, the cost and time involved in obtaining the large number of
long-term measurements, required to characterize understory conditions, is
substantial. Consequently, there is a need for indirect methods for estimating
daily, seasonal, and annual light regimes using various indexes or models.
Spatially explicit models of key resources driving mixedwood stand dynamics
have potential value in generalizing the results from field and greenhouse
experiments and other studies.
Understory light (PPFD) is inversely related to basal area of birch or red
alder (Comeau 1996). Consequently, growth of understory conifers would be
expected to decline as either density or size of the deciduous overstory trees
increase. The location of gaps in the broadleaf canopy relative to the conifer
can also influence light conditions and growth of conifers.
A variety of attempts have been made to develop simple indexes of light
reduction (eg. Messier and Puttonen 1995; DeLong 1991). However, these
simple indexes provide information that is only applicable to a certain time,
and most often under continuous canopies. Information on how light
conditions vary seasonally and annual integrations of light conditions may
more effectively describe observed variations in understory tree performance.
In addition, more sensitive methods are required to characterize light regimes
within and around canopy gaps or, alternatively, within and around patches of
broadleaves.
Calculating the amount of light underneath plant canopies requires
information on the amount and distribution of leaves in the canopy and the
amount of diffuse and direct sunlight reaching the canopy from each portion
of the sky. Hutchison and Matt (1977) present an interesting summary of how
understory light regimes change seasonally with changes in the amount of
solar radiation and the development of the stand leaf area index.
Grace et al. (1987) describe a process model for predicting light
interception by coniferous canopies which was an adaptation of earlier models
by Norman and Welles (1983). Pukkala et al. (1993) describe a similar model
for estimating light levels beneath canopies of Scots pine stands. These
models use stand map information together with simple models of crown
architecture of individual trees to estimate the distribution of leaf area in tree
canopies. They provide an excellent foundation for the construction of a
Windows compatible model that is capable of using LAI-2000 and stand
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map data as input for estimating understory light conditions.
Detailed measurements of crown architecture, particularly of the
distribution of leaf area, are required as a basis for calculating light
penetration. In forest stands this generally involves detailed mapping of
stem and crown locations, as well as measurement of crown length. Leaf
density within crowns is generally estimated using published or locally
developed regression estimators, that calculate leaf area as a function of dbh,
height or other parameters. The LI-COR LAI-2000 plant canopy analyzer
(LI-COR Inc., Lincoln, Nebraska) has potential use for estimating the fraction
of light penetrating broadleaf canopies and for estimating the amount of leaf
area in canopies (Gower and Norman 1991). The LAI-2000 sensor estimates
leaf area within each of 5 angular segments of the sky. Using view restrictors
it is possible to restrict the portion of the sky that the sensor views. By
collecting LAI-2000 readings from numerous points in a stand, either at
known locations or on a systematic grid, it is possible to map the spatial
distribution of leaf area in the tree canopy. LAI-2000 measurements can be
obtained rapidly, and may eliminate or reduce the need for development of
local regression estimators for tree leaf area, and may reduce the need for
other measurements.
Canham et al. (1988, 1994) describe a Global Light Index (GLI) which is
potentially useful for characterizing growing season light conditions in and
around gaps. GLI values represent the fraction of full sky light that reaches
the measurement point over the entire growing season. GLI is estimated from
fisheye photographs taken underneath the tree canopy.
This report describes the design and use of the model LITE which was
developed as a tool for estimating light penetration through tree canopies.
LITE was written for use with MS-Windows™ 3.1 or higher and requires
either LAI-2000 Plant Canopy Analyzer measurements (together with a file
describing the location of measurement points and height to crown base and
height to top of crown at each measurement point) or stem map data for the
stand, or both. LITE can be used to calculate the amount of light at any
particular date and time or to calculate totals for a desired period of time
(i.e., daily, weekly, monthly, seasonally). Both PPFD and fractional
transmission can be displayed. Results are displayed to the screen and can
be printed or exported to other applications.
The purpose of this report is to document the LITE program. It is intended
as both a behavioural description of the program and a users' manual.
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2 APPEARANCE AND STRUCTURE OF THE LITE PROGRAM

The APPLICATION FRAME is the main window that appears when the
2.1 Application
Frame Display and application starts. It is a display workspace used for windows created by the
application and houses the MAIN MENU. It is also the window that is
Main Menu
displayed when all files have been closed by the user.
Title bar
Control-menu box

Window title

Maximize button
Minimize button
Menu bar
Toolbar

Window border
Workspace

Status bar

The parts of the window are standard Windows elements:
• The Control-menu box is used to resize, move, maximize, minimize, and
close windows, and switch to other applications. To view this menu, click
on the box with a pointing device or type <Alt+space bar>.
• The Title bar shows the name of the application or document and is
highlighted when the window is active.
• The Window title is the name of the application or document.
• The Menu bar lists the available menu. In this example, the menu options
are File, View and Help. To view one of them, either click on the word
with a pointing device or type <Alt+the underlined letter>.
• Using a pointing device, such as a mouse or Glidepoint , the user can click
the Maximize button to enlarge the active application window so that it
fills the entire desktop, or click the Minimize button to reduce the window
to an icon.
• The Window border is the outside edge of a window. The border can be
used to enlarge or shrink a window by dragging the corner or border with
a pointing device. Position the pointing device over the border, click and
hold on the left button and then drag the border by moving the pointing
device without releasing the button. When the window is sized
appropriately, release the button.
• The Toolbar displays buttons under the main menu which can be used for
quick access to commonly used commands if the user has a pointing device
such as a mouse or Glidepoint .
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• The Status bar at the bottom of the window displays information about the
active document or highlighted command. The Status bar also shows the
state of the CapsLock, NumLock and ScrollLock keys. The example
above shows NumLock is activated.
• The Workspace holds any windows created by the application. These are
called child windows and are limited by the borders of the application
frame. Any child windows reduced to icons are kept on this workspace
and are managed by the application frame.
2.2 Multiple
Document
Interface

The program supports multiple instances of files using the Windows
Multiple Document Interface (MDI). Each file is displayed in its own child
window inside the application frame. The title bar of the active child window
is displayed with the colours that Windows uses to denote a highlighted title
bar (these colours will vary depending on how the system is set up). The active
child window (the one with the focus) is also referred to as the current window.
The menu bar changes depending upon the type of file (leaf area or tree stand)
displayed by the active window, and any commands invoked from the menu bar
will affect only the active window. The name of the file displayed by the
active window is also displayed on the title bar of the application frame. The
program also supports multiple views of a file which allows the user to see
both a display of the Leaf Area and of the Leaf Area Index of the same file
concurrently.

In the example above, the active child window is displaying the file
MAR24_16.LA and the LA menu bar is displayed. Also shown are an inactive
child window displaying the file H0701_16.LA, and the file DEC12_16.TSD,
reduced to an icon. The file DEC12_16.TSD can be activated by double-

clicking on it with a pointing device or by selecting it from the Window
menu. This will cause the active window to become inactive, the icon to
change into the active window, and the TSD menu bar to be displayed.
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3 OPENING PANEL

3.1 Main Menu

The MAIN MENU consists of three choices for user interaction: File, View
and Help. The File menu controls data input and output from the program.
The View menu controls the display of tool bars and status bars. The Help
menu displays information about the program and supports the user with online help.

3.1.1 File Menu
Allows the user to perform standard Windows™ file operations. With no
files open, the user is restricted to one of five choices: (1) creating a new file
(New); (2) opening an existing file (either with Open or by selecting a file
from the file list, if one exists); (3) setting up the printer for subsequent print
jobs (Print Setup); (4) setting global program options which define the way
LITE will operate (Options); and (5) or exiting the program (Exit). The
bottom section of this menu shows the last four files (TSD or LA) that were
opened or saved.
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New
There are two file-types that can be created: Leaf Area (LA) or Tree Stand
(TSD). The user is first prompted with the type of document to be created.
Next, the user is prompted to provide the name of an observation point map
file (see Observation Point Map File (*.map) on page 17). The new file is
named “untitled”. Some grayed-out menu items become available after a file
is created or loaded.
Document Type Prompt

This dialog box prompts the user for the type of document to create.
Currently, the user may create either a new LA document or a new TSD
document.

Observation Point Map File Prompt

This dialog box prompts the user for the name of the observation point map
data. The observation point data is read from the file and interpreted. See the
section Observation Point Map File (*.map) on page 17 for specifications
and information on these files. The appearance of the dialog box used to input
the filename will vary depending on the version and configuration of
Windows . If there are any errors on input, the user is notified by a pop-up
dialog box.
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If the warning option "Report when a duplicate stake in a map file is found" is
enabled and the program encounters two stakes with the same location, a
warning box will appear on the screen informing the user of this condition and
prompting them to either continue (deleting the second stake) or abort the
operation.

Open
Inputs an existing file. The file is loaded into the program and displayed on
the screen in a new window. The user can begin operations on the loaded file.
Previously loaded index files are unaffected by this operation. The dialog box
that appears will be very similar to the one used to input the map file name
(page 6) but will default to files with an extension of la or tsd.
Print Setup
The user is prompted to select a printer and given the option to redirect print
output to a file instead of a device. The is a standard dialog box in the
Windows environment.

Options
The Options menu item controls optional behaviour of the program such as
warning about input conditions, the default behaviour of tree species, and
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other behaviours. They are detailed below.
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Warning Options

The Warnings Options dialog box allows the user to specify which error
conditions to report. Only the application default behaviour can be accessed
from the opening panel, as no documents are loaded. Hence the Document
button is disabled.

Export Options

The user can export various types of data, as described in the TSD portion of
this document. The options in this dialog box specify the formatting of the
export files. Either a special character can be used to separate columns of data
(e.g., a comma), or the user can choose to align the columns.

Merge Options

The standard LAI2000 PCA angles have slight gaps between the rings. The
user has the option of using either the LAI2000 PCA angle specification or
LITE’s angle specification (which eliminates the gaps) when the .DAT files
are merged. The highest percentage to accept value specifies the breakover point at which the associated leaf area is deemed to be so minimal that it
should be eliminated. This value is used to mark the area of the crown space
as having no leaf area in an effort to more accurately represent the original
crown space of the stand by affecting the distribution of data in the .DAT
files.
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PPFD Calculations

This dialog lets the user specify the initial times and accuracy for PPFD
calculations when documents are initially created or re-opened. If a TSD
document is open, the user can choose between document and application
defaults. The Short-term PPFD Calc. Defaults button allows users to specify
the default time used for instantaneous calculations. The Long-term PPFD
Calc. Defaults section allows users to specify the start and end dates for longterm calculations, along with a time interval for both the calculations and
output of those calculations. If Current year is a leap year is checked, PPFD
calculations (after February 27 th) will be adjusted to take the extra day into
account. For example, if the user checked the box below, the short-term time
would be adjusted to read July 20 and the long-term interval would be
adjusted to start on July 20 and end July 21 and all PPFD calculations would
be adjusted accordingly. This option can be set at both the document and at
the application level.
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Application Species Values

Users have the ability to alter the default species coefficients at the application
level. When a new document is created, it inherits the species coefficients
from the application. Users who wish to change the species coefficients for all
new documents should change these values using the Application Species
Values menu option. Users who wish to change the species coefficients for a
single document should use the Document Species Values menu option. The
sequence of dialog boxes and options are the same for both the Application
Species Values and the Document Species Values and are shown below.
Each species has its own set of values, and may have different dialog boxes to
support different formulas. When this dialog is first opened, there is no
species in the Species box, and the associated buttons are disabled.

Diameter Limits

This dialog box allows the user to select a minimum and maximum diameter
limit for stems. These values are used to validate stem diameters when they
are imported from a file.

Leaf In/Drop Dates

Users can specify the leaf in and leaf drop behaviour for each species in their
area. The program assumes that there are no leaves before the Leaf In Start
date and no leaves after Leaf Drop End date. Between the Leaf In End and
Leaf Drop Start dates, the program assumes that all leaves are fully
developed. Between the start and end dates for Leaf In and Leaf Drop, the
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program uses linear interpolation to calculate leaf areas. If Species has leaf
in/drop dates is unchecked, that particular species will have a constant
canopy year-round and the buttons to change the leaf in/drop dates will be
disabled.

The following graph illustrates the methodology used. Before leaf in start,
there are no leaves (the ratio of full leaf in values is 0). Between leaf in start
and leaf in end, the program calculates the ratio as a value increasing from
0 to 1. Between leaf in end and leaf drop start, the leaves are fully developed
(the ratio of full leaf in values is 1). Between leaf drop start and leaf drop
end, the program calculates the ratio as a value decreasing from 1 to 0. And,
after leaf drop end, there are again no leaves.

Tree Morphology Coefficients

These coefficients are used to determine the dimensions of the crown of each
species of tree. Depending on how much data the user has provided for each
stem, the values specified in this dialog box may not be used for all stems. For
example, the crown extent for each quadrant can be specified by the user. If
the user has specified crown extent values, they will be used in place of the
formula and coefficients specified in this dialog box. The Crown Curvature
Calculation section allows the user to define the actual shape of the crown.
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The power factor for upper half of crown refers to the shape of the upper
half of the crown, power factor for lower half of crown refers to the shape
of the lower half, and ratio of crown belonging to upper half defines the
boundary for the upper and lower halves of the crown. For more information
on how these values affect crown shape, see 5.4.3 Crown Generation page
87. In the following example, "cl" stands for crown length, "ce" for crown
extent, "height" for stem height, "dbh" for diameter at breast-height, "p" for
the distance to the closest tree in the specified quadrant, and "log" to natural
logarithms.

Leaf Coefficients

These values are used by different formula s in the program. The Projection
Coefficient is used to determine how much light is intercepted by the leaves
of the given species. The Leaf Tip Angle is used to determine the vertical
projection of leaf area and the Specific Leaf Area is used to convert foliage
biomass to leaf area.

Foliage Biomass Coefficients

These coefficients are used to determine the amount of leaf area associated
with stems during crown generation, which takes place in the TSD portion of
LITE. As different equations are required for different species, different
dialog boxes will appear depending on which species were selected. The
following shows the dialog box used for Red Alder, where "dbh" is the
diameter at breast-height and "height" is the current height of the tree.
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Default Species Type

Any area in a TSD document which is not associated with a tree uses the
default species information for PPFD calculations. This allows PPFD to be
calculated even when the canopy is only partially (or not at all) associated
with trees.
Reset Species to Default

The users have the ability to quickly change species values back to a default
state, allowing users to correct mistakes or to apply values for a specific
region, tested in one document, to the application default values. A choice is
given among Ministry of Forests Research Branch defaults (which cannot
be modified), application defaults (which are saved in LITE’s INI file), or
values from the current document (this option is only enabled if a valid
TSD document is currently open).

Reset All Species Values

This option allows the user to reset all of the species values to a default.
Whereas ‘Reset Species to Default’changes all of the values associated with
one species, this option will change all the values of all the species to the set
of defaults selected by the user. The dialog box used for this option is
identical to that used for the "Reset Species to a Default" option (above).
File List
The four files most recently opened or saved are listed. The user may open
one of these files by selecting it.
Exit
The program exits to the Windows environment.
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3.1.2 View Menu
Selecting Toolbar, or Status Bar causes a check mark to appear beside the
option on the menu. These options can be selected at the same time, allowing
the user to display both on the screen.

Toolbar
Selecting this item from the menu will toggle the toolbar on the main window.
The toolbar, a group of buttons located directly under the main menu, can be
used for quick access to commonly used commands if the user has a pointing
device such as a mouse or Glidepoint .
Status Bar
Selecting this item from the menu will toggle the status bar. The status bar,
located at the bottom of the main window, provides information about the
active document or highlighted command and also shows the state of the
CapsLock, NumLock and ScrollLock keys.
3.1.3 Help Menu
This menu displays program information and supports the user with on-line
help. Index brings up a list of topics pertaining to LITE. Using Help brings
up information on how to use the Help menu system. About LITE brings up
the about-box for the program.
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Index
Displays a list of Contents for the Help. The user can choose one of the
topics by clicking on it with a pointing device or by selecting it with the Tab
key and then pressing Enter.
Using Help
This is a standard feature in the Windows environment. It explains how to
use Help.
About LITE
Displays information about the program, including version number and
copyright.
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4 CROWN GENERATION USING LAI 2000 PCA INTERPRETATION

This part of the program calculates the leaf area (LA) contained in each cubic
meter space and maps the distribution of LA within the stand. It combines the
light observations from an LAI 2000 Plant Canopy Analyzer (PCA) with data
associated with the observation point. The LA of the stand can be displayed
on the screen, printed, and/or recorded in a file.
The canopy of a stand is divided into one metre cubes. The cubes that
affect each PCA measurement point are identified and the LA of each cube is
determined and recorded. The axes for the cube space are aligned with the
users’plot area. Multiple light observation files can be combined or merged
into a single set of LA cubes.
LA can be displayed on the screen by the user. The view of the canopy is
determined by the user and is limited to either horizontal or vertical planes.
Additionally, vertical planes must parallel one of the user’s plot axes.
The sum of the LA in a vertical stack of cubes is the leaf area index ( LAI)
of the point under the stack. These values can be displayed on the screen in
the same format as LA or, additionally, written to a file for further use.
The program can display more than one plot on the screen at a time. It uses
the Windows Multiple Document Interface (MDI) to display and manage
more than one plot at a time. Multiple views of a document are also
supported, allowing the user to view the LA and the LAI of the same plot in
different child windows at the same time.
4.1 File Formats

4.1.1 Input Files
When working with LAI 2000 PCA data, the program requires both the PCA
data files and an observation point map file that provides information on the
location of each measurement point. The calculation of LA requires
information on the location of the base and top of the canopy at each point.
This is included in the observation point map file.
Observation Point Map File (*.map)
The observation map file has 3 functions:
1. It contains an azimuth reading in degrees (from true North) of the vector
from the origin to point (0,1) of the sample grid. The program uses this
value to orient the user's coordinate-space with compass readings (True
North).
2. It maps observation labels contained in the LAI 2000 light observations file
to (x,y) coordinates in metres. These coordinates are the points in the plot
where the observations were taken.
3. It contains the canopy data. Two heights, in metres, are needed for each
observation point, the height to the base of the crown and the height to the
top of the canopy.
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The file format is as follows:
<azimuth of (0,1)>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
…
where:
<azimuth of (0,1)>
<label>
<x>
<y>
<height to crown base>
<height to top of canopy>

::=
::=
::=
::=
::=
::=

integer (0, 360)
character*7
float (0, 100)
float (0, 100)
float (0, 100)
float (0, 100)

The program looks for a filename extension of map for these files. The user
may override the default and use any filename extension. An example of this
file can be found in Appendix C - Observation Point Map File (*.map) ,
page 93.
LAI 2000 Light Observations File (*.dat)
The format of these files is the same as that found in the LAI 2000 users’
guidebook. The program expects only one light observation per observation
point. If there is more than one observation at a point, the program will use
the last observation for that point. By default, the program looks for files with
an extension of dat. The user may override this default and use any filename
extension. The program matches "RSPS2" values in PCA data files with the
label given to specific grid points on the map file. The user should be careful
to ensure that matching labels are used in each file for each data point.
4.1.2 Input/Output Files
Leaf Area File (*.la)
The leaf area file is the product of this part of the program. The program has
the ability to read and write these files. Work in progress can be saved and
recalled for further processing. Completed files can be recalled for display
and printing. The leaf area file is also used in other parts of this program.
4.2 LA Main Menu

The LA MAIN MENU consists of four choices for user interaction: File, View,
Window and Help. The File menu controls data input and output from the
program. The View menu allows the user to select how the data will be
presented. The Window menu presents users with standard MDI options to
control windows created by the program. The Help menu displays information
about the program and supports the user with on-line help.
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4.2.1 File Menu
This menu allows the user to perform standard Windows™ file operations on
leaf area (LA) files. New allows LA files to be created. Open opens an
existing LA file. Close closes an open LA file. Save and Save As allows
users to save open LA files without closing them. Merge Data Files
combines light observations into the current LA file. Print prints the current
file, Print Preview allows users to check the output before it is printed, and
Print Setup allows users to set printer options for subsequent print jobs. The
Options menu item opens up another menu of choices which allow users to
set program options which define the way LITE will operate. Exit will exit the
program. The bottom section of this menu shows the last four files (LA or
TSD) that were opened or saved.
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New
There are two file-types that can be created: Leaf Area (LA) or Tree Stand
(TSD). The user is first prompted with the type of document to be created.
Next, the user is prompted to provide the name of an observation point map
file (see Observation Point Map File (*.map) on page 17). The new file is
named “untitled”. Some grayed-out menu items become available after a file
is created or loaded.
Document Type Prompt

This dialog box prompts the user for the type of document to create.
Currently, the user may create either a new LA document or a new TSD
document.

Observation Point Map File Prompt

This dialog box prompts the user for the name of the observation point map
data. The observation point data is read from the file and interpreted. See the
section Observation Point Map File (*.map) on page 17 for specifications
and information on these files. The appearance of the dialog box used to input
the filename will vary depending on the version and configuration of
Windows . If there are any errors on input, the user is notified by a pop-up
dialog box.

If the warning option "Report when a duplicate stake in a map file is found" is
enabled and the program encounters two stakes with the same location, a
warning box will appear on the screen informing the user of this condition and
prompting them to either continue (deleting the second stake) or abort the
operation.
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Open
Inputs an existing LA or TSD file. The file is loaded into the program and
displayed on the screen in a new window. The user can begin operations on
the loaded file. Previously loaded files are unaffected by this action. The
dialog box that appears will be very similar to the one used to input the map
file name (page 20) but will default to files with an extension of la or tsd.
Close
The current LA file is closed and its window in the program is removed. If the
file has changed since it was last saved, the user is prompted to save the
changes or discard them.
Save Changes on Close Prompt

The user is prompted to save or discard the changes made to the LA file. The
No button does not save any changes made since the last time the file was
saved. The Yes button on the panel saves the changes to the current file name.
The Cancel button will remove the message box from the screen and cancel
the Close request.

Save
The current LA file is saved to the disk. If it is a newly-created LA file, the
program will pop up the Save As dialog box, and the user is prompted for a
new file name.
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Save As
The current LA file is saved to the disk. The user is prompted for the name of
the file. The current file name is supplied as a default. The user can override
the default and save the data in a different file.

Merge Data Files
The Merge Data Files menu item is used to combine LAI 2000 light
observations into the current LA file. The user is prompted for the names of
files that contain the observations. The files are read and the data is
interpreted and merged into the current LA file.
Files to Merge

When the Merge Data Files option is selected, users are presented with a
Files to Merge dialog box. It is from this box that a list of files is constructed,
one at a time, by pressing the ‘Add File...’button. Files can also subsequently
be deleted by pressing the Delete Selected File button. When the list is
complete, the user must specify a view orientation and width as well as the
height that the light readings were taken. The default value is ground level,
and is assumed to be zero.
An example of a completed Files to Merge dialog box is shown below. The
user has selected a file called J:\LAISRC\RUN\SUR-WS7.DAT and files
merge angles are shown in the dialog box. Note that each file has its own
merge angles but all files share a single merge height.
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Add File to Merge

When the user presses the ‘Add File...’button on the Files to Merge dialog
box, a file-browser dialog will appear, prompting the user for a filename.
They are then prompted for information about the data in that file, after which
it is added to the list in the Files to Merge dialog box.

Merge Orientation Prompt

After the user has selected a file from the Add File to Merge dialog box, the
user is prompted for the orientation and for the angular width of the light
observation data in the file to be merged. Both values are in degrees, the
former is the azimuth of the centre of the field of view for the LAI-2000 from
true north and the latter is absolute degrees. The user types the information on
the panel, and it is checked for validity. The program assumes the orientation
given is the centre of the angular width. After pressing the OK button, the
program returns to the Files to Merge dialog box, with the newly-selected file
added to its list.

Print
The default printer is displayed, and the user is prompted to select the print
range and quality. This is a standard dialog box in the Windows
environment.
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Print Preview
Displays the current page as it will appear when printed. This is a standard
tool in the Windows environment.

Print Setup
This dialog box prompts the user to choose a printer and provides paper
orientation and size options. It is a standard dialog box in the Windows
environment.

Options
The Options menu item controls optional behaviour of the program such as
warning about input conditions, the default behaviour of tree species, and
other behaviours. They are detailed below.
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Warning Options

The program can report warnings for erroneous input conditions that may arise
when merging data into the current LA file. The user can choose to have these
conditions reported or not. The application defaults are stored in the
program's initialization file. The disabled options in the panel do not apply to
this part of the program.
The Document and Application Defaults buttons permit the user to store
the state of these options. When the Application Defaults button is selected,
the state of the input warnings are saved to the initialization file and will be
used for data added to any other stands. When the Document button is
selected, changes to the Warning Options are not kept. The input warnings are
applied only to the current stand.
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Export Options

The user can export various types of data, as described in the TSD portion of
this document. The options in this dialog box specify the formatting of the
export files. Either a special character can be used to separate columns of data
(e.g., a comma), or the user can choose to align the columns.

Merge Options

The standard LAI2000 PCA angles have slight gaps between the rings. The
user has the option of using either the LAI2000 PCA angle specification or
LITE’s angle specification (which eliminates the gaps) when the .DAT files
are merged. The highest percentage to accept value specifies the breakover point at which the associated leaf area is deemed to be so minimal that it
should be eliminated. This value is used to mark the area of the crown space
as having no leaf area in an effort to more accurately represent the original
crown space of the stand by affecting the distribution of information in the
.DAT files.

PPFD Calculations

This dialog lets the user specify the initial times and accuracy for PPFD
calculations when documents are initially created or re-opened. If a TSD
document is open, the user can choose between document and application
defaults. The "Short-term PPFD Calc. Defaults" button allows users to
specify the default time used for instantaneous calculations. The "Long-term
PPFD Calc. Defaults" section allows users to specify the start and end dates
for long-term calculations, along with a time interval for both the calculations
and output of those calculations. If Current year is a leap year is checked,
PPFD calculations (after February 27th) will be adjusted to take the extra day
into account. For example, if the user checked the box below, the short-term
time would be adjusted to read July 20 and the long-term interval would be
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adjusted to start on July 20 and end July 21 and all PPFD calculations would
be adjusted accordingly. This option can be set at both the document and at
the application level.

Application Species Values

Users have the ability to alter the default species coefficients at the application
level. When a new document is created, it inherits the species coefficients
from the application. Users who wish to change the species coefficients for all
new documents should change these values using the Application Species
Values menu option. Users who wish to change the species coefficients for a
single document should use the Document Species Values menu option. The
sequence of dialog boxes and options are the same for both the Application
Species Values and the Document Species Values and are shown below.
Each species has its own set of values, and may have different dialog boxes to
support different formulas. When this dialog is first opened, there is no
species in the Species box, and the associated buttons are disabled.
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Diameter Limits

This dialog box allows the user to select a minimum and maximum diameter
limit for stems. These values are used to validate stem diameters when they
are imported from a file.

Leaf In/Drop Dates

Users can specify the leaf in and leaf drop behaviour for each species in their
area. The program assumes that there are no leaves before the Leaf In Start
date and no leaves after Leaf Drop End date. Between the Leaf In End and
Leaf Drop Start dates, the program assumes that all leaves are fully
developed. Between the start and end dates for Leaf In and Leaf Drop, the
program uses linear interpolation to calculate leaf areas. If Species has leaf
in/drop dates is unchecked, that particular species will have a constant
canopy year-round and the buttons to change the leaf in/drop dates will be
disabled.

The following graph illustrates the methodology used. Before leaf in start,
there are no leaves (the ratio of full leaf in values is 0). Between leaf in start
and leaf in end, the program calculates the ratio as a value increasing from 0 to
1. Between leaf in end and leaf drop start, the leaves are fully developed (the
ratio of full leaf in values is 1). Between leaf drop start and leaf drop end, the
program calculates the ratio as a value decreasing from 1 to 0. And after leaf
drop end, there are again no leaves.
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Tree Morphology Coefficients

These coefficients are used to determine the dimensions of the crown of each
species of tree. Depending on how much data the user has provided for each
stem, the values specified in this dialog box may not be used for all stems. For
example, the crown extent for each quadrant can be specified by the user. If
the user has specified crown extent values, they will be used in place of the
formula and coefficients specified in this dialog box. The Crown Curvature
Calculation section allows the user to define the actual shape of the crown.
The power factor for upper half of crown refers to the shape of the upper
half of the crown, power factor for lower half of crown refers to the shape
of the lower half, and ratio of crown belonging to upper half defines the
boundary for the upper and lower halves of the crown. For more information
on how these values affect crown shape, see 5.4.3 Crown Generation, page
87. In the following example, "cl" stands for crown length, "ce" for crown
extent, "height" for stem height, "dbh" for diameter at breast-height, "p" for
the distance to the closest tree in the specified quadrant, and "log" to natural
logarithms.
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Leaf Coefficients

These values are used by different formula s in the program. The Projection
Coefficient is used to determine how much light is intercepted by the leaves
of the given species. The Leaf Tip Angle is used to determine the vertical
projection of leaf area and the Specific Leaf Area is used to convert foliage
biomass to leaf area.

Foliage Biomass Coefficients

These coefficients are used to determine the amount of leaf area associated
with stems during crown generation, which takes place in the TSD portion of
LITE. As different equations are required for different species, different
dialog boxes will appear depending on which species were selected. The
following shows the dialog box used for Red Alder, where "dbh" is the
diameter at breast-height and "height" is the current height of the tree.

Default Species Type

Any area in a TSD document which is not associated with a tree uses the
default species information for PPFD calculations. This allows PPFD to be
calculated even when the canopy is only partially (or not at all) associated
with trees.
Reset Species to Default

Allows users to change species values back to a default state, allowing users to
correct mistakes or to apply values for a specific region, tested in one
document, to the application default values. A choice is given among Ministry
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of Forests Research Branch defaults (which cannot be modified),
application defaults (which are saved in LITE’s INI file), or values from the
current document (this option is only enabled if a valid TSD document is

currently open).

Reset All Species Values

This option allows the user to reset all of the species values to a default.
Whereas ‘Reset Species to Default’changes all of the values associated with
one species, this option will change all the values of all the species to the set
of defaults selected by the user. The dialog box used for this option is
identical to that used for the "Reset Species to a Default" option (above).
File List
The four most recently opened or saved files are listed. The user may open
one of these files by selecting it.
Exit
The program exits to the Windows environment. The program checks all
open LA or TSD files for changes, and prompts the user to save or discard
changes before exiting.
Save Changes on Exit Prompt

The user is prompted to save or discard the changes made to any open LA or
TSD files. The dialog box that appears is similar to the one that is used for the
Save Changes Prompt for the Close menu option above. The Cancel button
will remove the Save Changes Prompt dialog box from the screen and cancel
the Exit request.
4.2.2 View Menu
The options on this menu allow users to change the look of the display.
Selecting Toolbar or Status Bar causes a check mark to appear beside the
option on the menu. These options can be selected at the same time, allowing
the user to display both on the screen. Values to Display changes what data
is displayed in the current window. Orientation of View changes what part of
the data is displayed in the current window. These menu items are mutually
exclusive within their section (only one view and one type of data may be seen
in a window at a time). Display Options annotates the display of the current
window. Display Method controls how the data is displayed. None, one, or
many of these options can be selected at a time. Display Settings gives the
user a centralized location (a single dialog box) from which to modify all the
view-options at once.
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Toolbar
Selecting this item from the menu will toggle the toolbar on the main window.
The toolbar, a group of buttons located directly under the main menu, can be
used for quick access to commonly used commands if the user has a pointing
device such as a mouse or Glidepoint .
Status Bar
Selecting this item from the menu will toggle the status bar. The status bar,
located at the bottom of the main window, provides information about the
active document or highlighted command and also shows the state of the
CapsLock, NumLock and ScrollLock keys.
Values to Display
Selecting this menu item brings up a list of options from which the user can
specify the data to be displayed. Only one option, which will have a check
mark beside it, can be selected at a time.
LA (Leaf Area)

Draws a map of LA on the screen. The LA is calculated for each square meter
of the current view and is displayed in the current window. The LA view is a
one metre thick horizontal or vertical slice of the canopy.
LAI (Leaf Area Index)

Draws a map of LAI on the screen. The LAI is calculated for each square
meter of the current view and is displayed in the current window. LAI is
defined as the sum of the LA above the current display elevation.
# Measurements per Cube

The number of measurements or observations that were used to determine the
LA of each cube is displayed in the current window. This option displays
values for a one metre thick horizontal or vertical slice of the canopy.
Orientation of View
Selecting this menu item brings up a list of options, from which the user can
choose a particular "orientation" (horizontal or vertical) for the data. Only one
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option, which will have a check mark beside it, can be selected at a time.
Horizontal View

This choice will draw a map of a plane parallel to the earth’s surface
intersecting the canopy. The user is prompted to select the height of the view
above the ground in metres. The maximum and minimum crown heights are
displayed in the dialog box to assist the user in making their selection. The
program then displays the data values (LAI, LA or # of measurements) of the
layer of cubes that are the selected distance above the ground.

Vertical View

This choice will draw a map of a plane perpendicular to the earth’s surface
intersecting the canopy. The plane must be parallel to one of the user’s axes.
The user is prompted to select either Up to Down (parallel to the Y-axis) or
the Left to Right (parallel to the X-axis), and the Coordinate (distance from
the origin) of the view in metres. The plot boundaries are displayed in the
dialog box to assist the user in making their selection. The program displays
the data values of the wall of cubes that are the selected distance from the
origin of the plot.

Display Options
Selecting this menu item brings up a list of options from which the user can
choose various elements to display as part of the output. Any options were
selected will have a check mark displayed beside them on the menu. If the
user subsequently deselects an option, the check mark associated with that
option will be erased. More than one option can be selected at a time,
allowing the user to overlay various elements on the screen display, or on the
printed output.
Show Stake Positions

Displays the positioning of the observation points read from the map file.
These are the points at which the canopy heights are measured and the LAI

CROWN GENERATION USING LAI 2000 PCA INTERPRETATION

34

2000 PCA readings were taken in the stand. Typically, stakes are driven into
the ground at these points.
Show Legend

Displays a shading legend consisting of eight display values (either colours or
patterns) and the actual data values used to create the display values. The
shading legend is displayed beside the actual display. Although only eight
colours are shown on the legend, sixty-four colours are actually used to paint
the display map.
Show Ruler

This option will display a border around the display of the plot. The border is
annotated with the size of the plot. This is useful when attempting to
determine the location of artifacts in the plot or when deciding offsets and
distances for views.
Display Method
Selecting this menu item brings up a list from which the user can control how
the data is displayed. Any options which have been selected will have a check
mark displayed beside them on the menu. If the user subsequently deselects
an option, the check mark associated with that option will be erased. More
than one option can be selected at a time, allowing the user to overlay colours,
patterns, and isolines on the screen display, or on the printed output.
Colour

Shades the map in the current window with colour. Colours do not overwrite
patterns nor isolines. Colours will not appear on printed output. Instead,
colours will be translated to patterns or grey scales.
Pattern

Uses patterns to shade the current map. Patterns are drawn over colours on
the screen but not over the isolines.
Isolines

Puts isolines on the current map. Isolines are drawn over any colours or
patterns currently on the screen.
Smoothing

Blurs the boundaries between the cubes displayed on the map using an
algorithm which calculates the output-value of a given point on the map by
taking the output-value of the cube in which the point resides and adjusting it
according to its proximity to its neighbouring cubes. The further from the
center of any given cube, the more the new output-value will be adjusted.
This results in a smoother-looking output.
Display Settings
As an alternative to menu toggles, a dialog box is available to make many
changes to the display from a centralized location.
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4.2.3 Window Menu
The Window menu presents users with standard MDI options to control
windows created by the program. The New Window option creates a copy of
the selected window. The Cascade option arranges all of the open windows
from the top left to the bottom right of the main program window. This allows
all of the title bars to be easily read. The Tile Horizontal and Tile Vertical
options arrange the open windows as smaller tiled windows in the main
program window. These option are useful for seeing a piece of each of the
open windows. The Arrange Icons option aligns all of the iconic
(minimized) windows in a row at the bottom of the main program window.
The Information Window toggles a window with information about the
selected map. The bottom section of this menu shows all of the open files,
whether in an open window or in icon form. The user can select the file of
choice using the mouse or the keyboard. The selected window is opened (if
minimized), brought to the front, and receives the input focus.
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New Window
Creates a copy of the current window and gives it the input focus. The user
can then select a different view of the same stand. This is the standard
Windows tool for allowing a user to create a new view of the same document.
Cascade and Tile Selections
The Cascade selection causes all of the open windows to be cascaded inside
the main application window. After windows have been cascaded, their title
bars and system menus are visible and accessible, allowing the user to easily
find and display a particular one.
The Tile selection causes all of the open windows to be tiled either
horizontally or vertically inside the main application window. This is useful
for displaying two or more windows at their maximum size simultaneously.
The user selects the format, vertical or horizontal, that is most appropriate for
viewing their data. If the user has more open windows than they wish to tile,
they must minimize the excess windows (making them icons) before selecting
Tile.
Arrange Icons
This selection causes all of the minimized windows (icons) inside the
application window to be arranged neatly along the bottom of the application
window.
Information Window
This dialog displays basic instantaneous values for a point on the map. From
this dialog, the user may specify a different point on the map by pressing the
"location" button. This dialog can also be accessed by clicking directly on a
point in the map window.

Location

From this dialog, information can be entered to pinpoint a specific map
location. The user is prompted to enter the X and Y coordinates (where 0,0 is
in the lower, left-hand corner of the map), along with an elevation. Any
numbers entered which are out of range will be modified to fit the range of
valid data.
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4.2.4 Help Menu
This menu displays program information supports the user with on-line help.
Index brings up a list of topics pertaining to LITE. Using Help brings up
information on how to use the Help menu system. About LITE brings up the
about-box for the program.

Index
Displays the Contents page for the LAI 2000/Tree Stand Modelling Help.
The user can choose one of the topics by clicking on it with a pointing device
or by selecting it with the Tab key and then pressing Enter.
Using Help
This is a standard feature in the Windows environment. It explains how to
use Help.
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About LITE
Selecting this option displays a dialog box with information about the
program, including the version number, copyright and license.

4.3 Calculations
and Algorithms

4.3.1 Plot Extents
The plot extents are calculated as a bounding box around the user's plot. The
horizontal limits are defined by a rectangle just large enough to hold all of the
user's stake positions. The vertical limits are defined by the maximum crown
height and minimum height to crown base provided by the user at each stake
location in the map file.
4.3.2 Canopy Cube and Angular View Intersection
Each PCA measurement provides an estimate of diffuse non-interceptance
through a set of canopy cubes. The set of cubes associated with a particle
measurement is determined using the geometry of the view. For a single plane
of cubes at a known height, h, two arcs are drawn. The outer or larger arc is
formed by projecting the lower view angle, l, from the observation point on to
the plane of cubes. The inner or smaller arc is formed by projecting the upper
view angle, u, on to the plane of cubes. Both projections are constrained by
view width and direction entered by the user. The arcs will be complete
circles if the user is working with 360° views.
The formula for the inner arc is r = h tan u , centred at the observation point,
and the formula for the outer arc is r = h tan l , centred at the same point.
The cubes that lie between these arcs are in the set that will be affected by
the light calculations from the observation point. The complete set is formed
by enumerating the heights between the base of the crown and the top of the
canopy.
4.3.3 Leaf Area Determination
The average leaf area (LA) of the set of cubes that affect an observation is
based on the formula from the LAI 2000 PCA handbook (LiCOR Inc. 1993).
Formulas from the handbook are for an entire 180° view of the hemisphere.
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The following derivation is designed to calculate the foliage density for the
field of view of a single PCA sensor ring. From the handbook, foliage density
of the hemisphere is
π /2

µ=2 ∫

− ln(T (θ))
S(θ)

0

sin(θ)dθ

where:
θ

= angle of view of the hemisphere
T (θ) = gap fraction ratio
S(θ) = length of ray through canopy
approximated by

1
z
cos(θ)

z = canopy thickness

By restricting the view to a smaller portion of the hemisphere, the following
formula is derived
θu
− ln(T (θ))
sin(θ)dθ
µ=2∫
S(θ c )
θl

where:
θ l = opening angle
θ u = closing angle
θ c = angle of center
θ − θl
θl + u
2

Note that the integral is still doubled since the angle of inclusion is
encountered twice, once while sweeping upwards and once while sweeping
downwards. This is still valid when the viewport of the device is masked,
since both the above canopy and below canopy sensors are masked identically
and the device uses spatial averaging over the entire hemisphere.
Extracting measurement data from the integral leaves the following
formula:
µ=2

− ln( Ti ) θ u
S(θ c )

∫sin(θ)dθ

θl

θu

The integral portion of this formula, ∫sin(θ)dθ , is used to weight the
θl

measurement for the portion of sky seen from θ l to θ u . By using a weight of
1 in place of this integral, the following formula is attained for the foliage
density of the i th ring:
µ=2
=2

− ln(Ti )
S (θ c )

− ln(Ti )
z

(cos(θ c ))
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Since the annular angles are fixed, a table of constants for each of the rings
of the LAI 2000 is used.
i

(

θu
θl
θc

)

c i = 2 cos(θ c )

1
0
13
6.5
1.9871

2
16
28
22
1.8544

3
32
43
37.5
1.5867

4
47
58
52.5
1.2175

5
61
74
67.5
0.7654

Lastly, the canopy thickness, zi, is computed along the center angle, θ c , in
the direction of the view entered by the user. This is accomplished by
determining the first entry and last exit of the intersection of this line and the
canopy. Then the foliage density for the cubes that affect each of the annular
rings can be computed using the following formula:

µi =

− ln(Ti )
ci
zi

A running average of the LA of each cube is kept along with the number of
times the cube was intersected by some angular view. A single cube may be
intersected by many observations. The running average will assign as many
observations to each cube as possible.
4.3.4 Leaf Area Index
The leaf area index for each square metre can be computed by summing the
leaf area of all the cubes directly above the square. This value is leaf area in
metres2 per square metre of ground area.
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5 TREE STAND AND LIGHT MODELLING

This section of the program prepares a crown map from tree list data (if
available) and calculates Photosynthetic Photon Flux Densities (PPFD) at
points in a model stand. The program calculates direct, diffuse and total
PPFD. PPFD can be displayed on the screen, printed and recorded in a file.
The canopy of the stand is divided into one metre cubes. The amount of
light that penetrates each canopy cell is calculated based on the species that
generated the foliage in that cell. The user creates the model stand by
specifying tree parameters. Alternately, the program can read in a Leaf Area
(LA) file that provides data on the LA in each canopy cell and use the map to
calculate the extinction of light through the canopy.
For this section of the program, the user must provide a tree list in the form
of a *.stm file (see Stem List File (*.stm), page 42).
PPFD can be displayed on the screen by the user. The view of the canopy
is determined by the user and is limited to horizontal or vertical planes.
Vertical planes must parallel one of the user’s plot axes. Stem maps, crown
maps and/or LA maps may be also be shown or printed with the PPFD. %
transmittance can also be calculated and displayed independently or with
PPFD.
The program can display more than one stand on the screen at a time using
the Windows Multiple Document Interface (MDI).
5.1 File Formats

5.1.1 Input Files
Observation Point Map File (*.map)
The observation map file has 3 functions:
1. It contains an azimuth reading in degrees (from true North) of the vector
from the origin to (0,1) of the user coordinates. The program uses this value
to orient the user's coordinate space with compass reading (True North).
2. It maps observation labels contained in the LAI 2000 light observations file
to (x,y) coordinates in metres. These coordinates are the points in the plot
where the observations were taken.
3. It contains the canopy data. Two heights are needed for each observation
point, the height to the base of the crown and the height to the top of the
canopy.
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The file format is as follows:
<azimuth of (0,1)>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
<label> (<x>, <y>) <height to crown base> <height to top of canopy>
…
where:
<azimuth of (0,1)>
<label>
<x>
<y>
<height to crown base>
<height to top of canopy>

::=
::=
::=
::=
::=
::=

integer (0, 360)
character * 7
float (0, 100)
float (0, 100)
float (0, 100)
float (0, 100)

The program looks for a filename extension of map for these files. The user
may override the default and use any filename extension. An example of this
file can be found in Appendix C - Observation Point Map File (*.map) ,
page 93.
Leaf Area File (*.la)
The leaf area file is the product of the LAI 2000 PCA Instrument
Interpretation portion of the program. The Crown Generation and Light
Modelling portion can read these files and display them as the canopy of a
stand.
5.1.2 Input/Output Files
Stem List File (*.stm)
The stem list file describes each tree in the stand. Each tree in the list has the
following properties:
• User-ID (valid only for file versions 2 and 4) (ASCII string, up to 8
characters in length)
• 2-3 letter species code:
MB Bigleaf Maple
EP
Paper Birch
AT Trembling Aspen
AC Black Cottonwood/Balsam Poplar
DR Red Alder
FIR BC Conifer
• x and y coordinates (metres)
• diameter at breast height (dbh) (mm in file versions 1 and 2; cm in
versions 3 and 4)
• lean percent (0 - 90 degrees)
• lean direction (0 - 360 degrees)
• height (metres)
• height to crown base in each of 4 quadrants (N,E,S,W) (metres, ranging
from 0 to height)
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• crown extent in each of 4 quadrants (N,E,S,W) (metres)
• (projected) leaf area of the tree
The user can provide a subset of the list and have the program generate the
missing parameters. Four subsets are currently supported:
• (user-id), species code, x, y, dbh, lean percent and lean direction,
• (user-id), species code, x, y, dbh, lean percent, lean direction, and height,
• (user-id), species code, x, y, dbh, lean percent, lean direction, height and
height to crown base.
• (user-id), species code, x, y, dbh, lean percent, lean direction, height and
height to crown base, leaf area of tree.
Users are free to mix the subsets for different stems in the same file as
exemplified in Appendix B - Stem List File (*.stm) page 92.
Any modifications made to the tree list within this section of the program
can be output as a modified .stm file.
Open Sky PPFD File (*.pfd)
Open sky PPFD files contain PPFD values from a nearby weather station or
recording site. The values are expected on an hourly basis for an entire year.
The program expects three numbers per line, separated by whitespace
(blanks or tabs). The first number is the day of the year (expressed in Julian
Days, where January 1 st = 1), the second is the time of day based on a 24 hour
clock and the third is the PPFD recorded at that time. The day of the year and
the time are expected to be in local standard time. This data is used to
calculate diffuse and direct PPFD. The user will be prompted to fill in any
missing values (see Load PPFD Values, page 60). An example of this file
can be found in Appendix A - Open Sky PPFD File (*.pfd), page 91.
Any modifications made to the PPFD values within this section of the
program can be output as a modified .pfd file.
Tree Stand Files (*.tsd)
The tree stand file is generated by this program and contains the stand
description, including a tree list (stem file) and a three dimensional canopy
structure similar in design to a LA file.
System Configuration File (ppfd.ini)
The system configuration file contains system information, including leaf area
constants and projection coefficients for each species. This file is intended for
machine interpretation only. Users are discouraged from altering this file
directly. It is maintained automatically by the program.
5.1.3 Output Files
The files which can be exported are described in the section 5.4.2
Calculation of Exported Values on Page 85.
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5.2 Tree Stand
Modelling Main
Menu

The TREE STAND MODELLING MAIN MENU consists of seven choices
for user interaction: File, Atmosphere, Crown, Stems, View, Window and
Help. The File menu controls data input and output from the program. The
Atmosphere menu allows the user to inspect and modify the global location of
the plot as well as the environmental conditions. The Crown menu controls
crown data input and output. The Stems menu controls tree list data input and
output. The View menu allows the user to view different displays and to select
how the display will be presented. The Window menu presents users with
standard MDI options to control windows created by the program. The Help
menu displays information about the program and supports the user with online help.

5.2.1 File Menu
This menu allows the user to perform standard Windows™ file operations on
tree stand (TSD) files. New allows TSD files to be created. Open opens an
existing TSD file. Close closes an open TSD file. Save and Save As allow
users to save open TSD files without closing them. Export takes data from an
open TSD file and places it in an ASCII file. Print prints the current file,
Print Preview allows users to check the output before it is printed, and Print
Setup allows users to set printer options for subsequent print jobs. The
Options menu item opens up another menu of choices which allow users to
set program options which define the way LITE will operate. Exit will exit the
program. The bottom section of this menu shows the last four files (LA or
TSD) which were opened or saved.
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New
There are two file-types that can be created: Leaf Area (LA) or Tree Stand
(TSD). The user is first prompted with the type of document to be created.
Next, the user is prompted to provide the name of an observation point map
file (see Observation Point Map File (*.map) on page 17). The new file is
named “untitled”. Some grayed-out menu items become available after a file
is created or loaded.
Document Type Prompt

This dialog box prompts the user for the type of document to create.
Currently, the user may create either a new LA document or a new TSD
document.
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Observation Point Map File Prompt

This dialog box prompts the user for the name of the observation point map
data. The observation point data is read from the file and interpreted. See the
section Observation Point Map File (*.map) on page 17 for specifications
and information on these files. The appearance of the dialog box used to input
the filename will vary depending on the version and configuration of
Windows . If there are any errors on input, the user is notified by a pop-up
dialog box.

If the warning option "Report when a duplicate stake in a map file is found" is
enabled and the program encounters two stakes with the same location, a
warning box will appear on the screen informing the user of this condition and
prompting them to either continue (deleting the second stake) or abort the
operation.

Open
Inputs an existing TSD or LA file. The file is loaded into the program and
displayed on the screen in a new window. The user can begin operations on
the loaded file. Previously loaded files are unaffected by this action. The
dialog box that appears will be very similar to the one used to input the map
file name (page 45) but will default to files with an extension of tsd or la.
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Close
The current TSD file is closed and its window in the program is removed. If
the file has changed since it was last saved, the user is prompted to save the
changes or discard them.
Save Changes on Close Prompt

If any changes were made to the TSD file, the user is prompted to save or
discard the changes made. The No button does not save any changes made
since the last time the file was saved. The Yes button on the panel saves the
changes to the current file name. The Cancel button will remove the message
box from the screen and cancel the Close request.

Save
The current TSD file is saved to the disk. If it is a newly-created TSD file, the
program will pop up the Save As dialog box, and the user is prompted for a
new file name.
Save As
The current TSD file is saved to the disk. The user is prompted for the name
of the file. The current file name is supplied as a default. The user can
override the default and save the data in a different file.
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Export
Allows users to export either the current view (Export Current View) or
above and below canopy readings (Export Atmospheric Readings).

Export Current View

Creates an output (text) file with values (LA, LAI, PPFD, % PPFD
Transmittance, etc.) culled from the current view. Upon selecting this menu
item, a file save dialog will appear, prompting the user for the name and
location of the text file to be exported. Formatting of the export file is
explained in 5.4.2 Calculation of Exported Values on page 85.

Export Atmospheric Readings

Various above and below canopy PPFD readings can be exported. The user
may specify the duration ( Start, End) and accuracy (Interval) of calculations,
as well as how often values will be exported to the appropriate files ( Output
Interval). For below canopy readings, the user must also specify the point at
which such readings are calculated (Location). If the Produce Below
Canopy Readings File checkbox is unchecked, the Location button will be
disabled. A file name must be specified for each output type requested,
otherwise an error message will occur. If the user presses the browse button, a
dialog box similar to the Export Current View box (above) appears,
prompting the user for a filename which, after the user presses OK, is inserted
into the appropriate Filename box. Alternately, the user can simply type a
valid filename directly into the Filename box.
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Print
The default printer is displayed and the user is prompted to select the print
range and quality. This is a standard dialog box in the Windows
environment.

Print Preview
Displays the current page as it will appear when printed. This is a standard
tool in the Windows environment.
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Print Setup
This dialog box prompts the user to choose a printer and provides paper
orientation and size options. It is a standard dialog box in the Windows
environment.

Options
The Options menu item controls optional behaviour of the program such as
warning about input conditions, the default behaviour of tree species, and
other behaviours. They are detailed below.

Warning Options

The program can report warnings for erroneous input conditions that may arise
when working with TSD files. The user can choose to have these conditions
reported or not. The application defaults are stored in the program's
initialization file. The disabled options in the panel do not apply to this part of
the program.
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The Document and Application Defaults buttons permit the user to store
the state of these options. When the Application Defaults button is selected,
the state of the input warnings are saved to the initialization file and will be
used for data added to any other stands. When the Document button is
selected, changes to the Warning Options are not kept. The input warnings
are applied only to the current stand.

Export Options

The user can export various types of data, as described in the TSD portion of
this document. The options in this dialog box specify the formatting of the
export files. Either a special character can be used to separate columns of data
(e.g., a comma), or the user can choose to align the columns.
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Application Merge Options

The standard LAI2000 PCA angles have slight gaps between the rings. The
user has the option of using either the LAI2000 PCA angle specification or
LITE’s angle specification (which eliminates the gaps) when the .DAT files
are merged. The highest percentage to accept value specifies the breakover point at which the associated leaf area is deemed to be so minimal that it
should be eliminated. This value is used to mark the area of the crown space
as having no leaf area in an effort to more accurately represent the original
crown space of the stand by affecting the distribution of information in the
.DAT files. The Document button is disabled in this dialog, because only LA
files are affected by the options chosen here, however application-wide
defaults can be set.

PPFD Calculations

This dialog lets the user specify the initial times and accuracy for PPFD
calculations when documents are initially created or re-opened. If a TSD
document is open, the user can choose between document and application
defaults. The "Short-term PPFD Calc. Defaults" button allows users to
specify the default time used for instantaneous calculations. The "Long-term
PPFD Calc. Defaults" section allows users to specify the start and end dates
for long-term calculations, along with a time interval for both the calculations
and output of those calculations. If Current year is a leap year is checked,
PPFD calculations (after February 27th) will be adjusted to take the extra day
into account. For example, if the user checked the box below, the short-term
time would be adjusted to read July 20 and the long-term interval would be
adjusted to start on July 20 and end July 21 and all PPFD calculations would
be adjusted accordingly. This option can be set at both the document and at
the application level.
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Application/Document Species Values

Users have the ability to alter the default species coefficients at the application
level. When a new document is created, it inherits the species coefficients
from the application. Users who wish to change the species coefficients for
all new documents should change these values using the Application Species
Values menu option. Users who wish to change the species coefficients for a
single document should use the Document Species Values menu option. The
sequence of dialog boxes and options are the same for both the Application
Species Values and the Document Species Values and are shown below.
Each species has its own set of values, and may have different dialog boxes to
support different formulas. When this dialog is first opened, there is no
species in the Species box, and the associated buttons are disabled.
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Diameter Limits

This dialog box allows the user to select a minimum and maximum diameter
limit for stems. These values are used to validate stem diameters when they
are imported from a file.

Leaf In/Drop Dates

Users can specify the leaf in and leaf drop behaviour for each species in their
area. The program assumes that there are no leaves before the Leaf In Start
date and no leaves after Leaf Drop End date. Between the Leaf In End and
Leaf Drop Start dates, the program assumes that all leaves are fully
developed. Between the start and end dates for Leaf In and Leaf Drop, the
program uses linear interpolation to calculate leaf areas. If Species has leaf
in/drop dates is unchecked, that particular species will have a constant
canopy year-round and the buttons to change the leaf in/drop dates will be
disabled.

The following graph illustrates the methodology used. Before leaf in start,
there are no leaves (the ratio of full leaf in values is 0). Between leaf in start
and leaf in end, the program calculates the ratio as a value increasing from 0 to
1. Between leaf in end and leaf drop start, the leaves are fully developed (the
ratio of full leaf in values is 1). Between leaf drop start and leaf drop end, the
program calculates the ratio as a value decreasing from 1 to 0. And after leaf
drop end, there are again no leaves.
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Tree Morphology Coefficients

These coefficients are used to determine the dimensions of the crown of each
species of tree. Depending on how much data the user has provided for each
stem, the values specified in this dialog box may not be used for all stems.
For example, the crown extent for each quadrant can be specified by the user.
If the user has specified crown extent values, they will be used in place of the
formula and coefficients specified in this dialog box. The Crown Curvature
Calculation section allows the user to define the actual shape of the crown.
The power factor for upper half of crown refers to the shape of the upper
half of the crown, power factor for lower half of crown refers to the shape
of the lower half, and ratio of crown belonging to upper half defines the
boundary for the upper and lower halves of the crown. For more information
on how these values affect crown shape, see 5.4.3 Crown Generation, page
87. In the following example, "cl" stands for crown length, "ce" for crown
extent, "height" for stem height, "dbh" for diameter at breast-height, "p" for
the distance to the closest tree in the specified quadrant, and "log" to natural
logarithms.
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Leaf Coefficients

These values are used by different formula s in the program. The Projection
Coefficient is used to determine how much light is intercepted by the leaves
of the given species. The Leaf Tip Angle is used to determine the vertical
projection of leaf area and the Specific Leaf Area is used to convert foliage
biomass to leaf area.

Foliage Biomass Coefficients

These coefficients are used to determine the amount of leaf area associated
with stems during crown generation, which takes place in the TSD portion of
LITE. As different equations are required for different species, different
dialog boxes will appear depending on which species has been selected. The
following shows the dialog box used for Red Alder, where "dbh" is the
diameter at breast-height and "height" is the current height of the tree.

Default Species Type

Any area in a TSD document which is not associated with a tree uses the
default species information for PPFD calculations. This allows PPFD to be
calculated even when the canopy is only partially (or not at all) associated
with trees.
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Reset Species to Default

The users have the ability to quickly change species values back to a default
state, allowing users to correct mistakes or to apply values for a specific
region, tested in one document, to the application default values. A choice is
given among Ministry of Forests Research Branch defaults (which cannot
be modified), application defaults (which are saved in LITE’s INI file), or
values from the current document (this option is only enabled if a valid
TSD document is currently open).

Reset All Species Values

This option allows the user to reset all of the species values to a default.
Whereas ‘Reset Species to Default’changes all of the values associated with
one species, this option will change all the values of all the species to the set
of defaults selected by the user. The dialog box used for this option is
identical to that used for the "Reset Species to a Default" option (above).
File List
The four most recently opened or saved files are listed. The user may open
one of these files by selecting it.
Exit
The program exits to the Windows environment. The program checks all
open TSD and LA files for changes, and prompts the user to save or discard
changes before exiting.
Save Changes on Exit Prompt

The user is prompted to save or discard the changes made to the TSD or LA
file. The dialog box that appears is similar to the one that is used for the Save
Changes Prompt for the Close menu option above. The Cancel button will
remove the Save Changes Prompt dialog box from the screen and cancel the
Exit request.
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5.2.2 Atmosphere Menu
This menu allows users to inspect and modify conditions which relate to
location and environment. Plot Location allows the specification of global
location for the plot. Plot Horizon enables the modification of the horizon
from its default position. Date allows users to specify the date used for
calculations. Load PPFD Values reads in yearly plot data from an ASCII file,
and Save PPFD Values saves plot data to an ASCII File. Modify Conditions
for 1 Day and Modify Monthly Conditions allows users to edit environmental
conditions. The bottom section of this menu shows the last four PPFD files
which were loaded or saved.

Plot Location
This dialog allows the user to specify the geographic location and time zone of
the plot. This data is used for tracking the location of the sun in the sky, and
adjusting local time information that is input from other sources. These values
are saved with the TSD file and, as a rule, do not need to be entered more than
once. The user can enter any valid Latitude (either North or South, and
ranging from 0 to 90 degrees) or Longitude (either East or West, and ranging
from 0 to 180 degrees). The Time Zone can be entered either as one of named
time zones (Alaska, Pacific, Mountain, Central, Eastern, or Atlantic) for North
America or by entering an adjustment factor to Greenwich Mean Time
(GMT). When the user selects a named time zone, the program displays the
associated time adjustment factor. If the user enters an adjustment factor, it
must be entered according to the standard Windows™ time format
(hours:minutes:seconds).
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Plot Horizon
This dialog allows users to create a variable horizon. The default is 8.63° off
horizontal (the effect of which is to eliminate the bottom three sets of cells).
However, the user may wish to enter different numbers, for example, to model
a mountain or cliff. The user can click Constant horizon for plot and enter a
constant value for Elevation of horizon or click Variable horizon for plot
and enter a separate value for each of the 24 divisions of azimuth. Note: the
orientation of the 24 divisions (to North) will coincide with the orientation of
the plot itself (as indicated by the compass heading at the centre of the dialog).

Date
This option allows the user to specify the local date and time used to calculate
instantaneous PPFD values. Time must be entered in standard Windows™
time format (hours:minutes:seconds).

Load PPFD Values
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This option loads hourly open sky PPFD readings for up to one full year taken
from a weather station. The file format is described in the section Open Sky
PPFD File (*.pfd) on Page 42. These values are used to determine the
overcast condition and partition available light into direct and diffuse sources.
The open sky PPFD values are subsequently stored in the current TSD file.
They are saved with and restored from the TSD file and, as such, are normally
only entered once.

If any values are missing from the PPFD file, a warning box will appear
provided that option has not been disabled on the Warnings menu.

The default replacement value is zero. If the user changes the number (in
the New Value box), the new number is used as a default for the rest of the
missing values. If the user unchecks the option Continue to warn on this
condition, the warning box is closed, and the current default is used for the
remainder of missing values. If the user has disabled the warning box in the
Warnings menu, zero will be used for all missing values. The default value in
the New Value box is reset to zero, and the option to continue to warn users is
turned on each time this operation is performed.
Save PPFD Values
This option saves current hourly open sky PPFD readings to an Open Sky
PPFD file in the file format described in the section Open Sky PPFD File
(*.pfd) on Page 42.
Modify Conditions for 1 Day
The user may at any time inspect and modify the open sky light conditions for
a particular day. This dialog box has two modes, Hourly Readings and Daily
Condition. To select the mode by which the weather conditions will be
stored, the corresponding button must be clicked.
Hourly Readings Mode
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In this mode, the weather conditions for the date specified in the date-field
(June 21st, in this example) are specified using hourly readings given in local
time. The corresponding daily transmissitivity value is calculated from the
noon local standard time reading. Selecting a particular list entry (hour) and
modifying the corresponding value (for that hour) in the PPFD edit-field
allows the user to modify any hourly reading. In this mode, the user cannot
directly enter a daily condition or transmissitivity value.

Daily Condition Mode

In this mode, daily weather conditions are set by specifying the
transmissitivity. Some daily conditions are pre-set, but the user has the option
of directly specifying the transmissitivity. The hourly readings, which cannot
be directly edited, will be calculated from the transmissitivity value specified.
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Modify Monthly Conditions
This option allows the user to specify daily transmissitivity conditions for an
entire month. The user must specify the number of days for each weather
condition, so that total days is equal to the number of days in the selected
month. In this example, the program will set daily conditions to "clear" for 10
days in July.

Atmosphere Conditions File List
The four most recently loaded Open Sky PPFD files (*.pfd) are listed. The
user may attach one of these files by simply selecting it.
5.2.3 Crown Menu
This menu controls crown data input and output. Attach opens a file (LA or
TSD) and attaches its crown to a TSD file. Save and Save As save the
current canopy as an LA file. Generate generates crowns in the crown space,
using the current tree list. Distribute Between Stems distributes the crown
space among the existing stems. Thin Stem sets the mouse to selectively thin
the stems of a TSD file and Unthin Stems turns this option off. The bottom
section of this menu shows the last four files (LA or TSD) that were attached
or saved.
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Attach
Opens an LA or TSD file and attaches its crown to the current TSD file. The
LA file becomes the new canopy of the stand. Any existing canopy is
discarded, regardless of whether the existing canopy was attached or
generated. If there is a stem list in the TSD file, the canopy can be
automatically distributed among the stems using the method described in the
section Distribute Between Stems on Page 64. The new crown must have
been created with the same map file as the original in order for the operation
to be carried out.
Crown Attach File Prompt

This dialog box prompts the user for the name of the file containing the
canopy. The data is read from the LA file and interpreted. If there are any
errors, the user is notified by a pop-up dialog box. The appearance of the
dialog box used to input the file name will vary from system to system
depending on the version and configuration of Windows in use.

Save
The current canopy is saved as an LA file to the disk. If it is a newly created
file, the program will pop up the Save As dialog box, and the user will be
prompted for a new file name.
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Save As
The current crown file is saved to the disk. The user is prompted for the name
of the file. The current file name is supplied as a default. The user can
override the default and save the data in a different file.

Generate
The current tree list is used to generate crowns in the crown space. The tree
parameters are used to create crowns specific to each tree based on its size,
species, neighbors, etc. This replaces the current crowns regardless of
whether they were generated or attached. When the user chooses this option,
a message box will appear allowing the option of clearing any information
previously calculated which flagged certain cubes (sections of the stand
canopy) as unable to contain LA.

At the point where LA files are merged, calculations are done to determine
which cubes should not contain LA. This option allows the user to discard
those calculations and enable those particular cubes to contain LA when the
crowns are generated. Note: this message box will appear regardless of
whether or not any cubes have been flagged. If the current stand contains no
stems, this menu item will be disabled.
Distribute Between Stems
The crown space is distributed amongst the existing stems. If no stems were
created or attached, then this menu item is disabled. The program uses a
Delauney tesselation to partition the crown space into Voronoi regions around
each stem.
Thin Stem
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This menu item sets the mouse mode to selectively thin stems which belong to
the file. When this mode is selected, the status bar will reflect this and the
menu item will be checked. When the user selects a stem (a point on the
map), a Thin Stem dialog box will appear to confirm the user’s action.
Thinning an existing stem does not remove it, but marks the crown associated
with the stem as non-existent. This is not a destructive operation, as the stem
can be unthinned, restoring its crown to its previous values. This option will
stay in place until the user "de-selects" the menu option, causing the check
mark to disappear.
Thin Stem Dialog

If the Thin stem option has been activated, when the user selects a point on
the map by clicking on it, this dialog appears, with information about that
particular stem. The user has the option of thinning the stem by pressing the
OK button or selecting another stem by editing the Index field. All other
options are disabled.

Unthin Stem
This menu option sets the mouse mode to reverse the operation of the Thin
Stem option. It similarly to the Thin Stem dialog box (above) when the user
selects a point on the map.
Crown File List
The four most recently attached or saved crown as LA files are listed. The
user may attach one of these files by selecting it.
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5.2.4 Stems Menu
This menu controls the input and output of tree list data. Attach loads an
ASCII stem list file. Save and Save As saves the current stem list to an
ASCII file. Automatic Renumbering renumbers the stem list consecutively.
Remove Extra Stems removes extraneous stems. Collect LA from Merged
Data uses the data to calculate the leaf area for the stems (as opposed to predefined equations). Clear removes all of the stems from the current tree stand
file. Enter, Edit and Delete allow for the input, removal and modification of
individual tree data. Show Stem Positions draws the stem map on the
display of the current stand map. The bottom section of this menu shows the
last four stem list files (STM) that were attached or saved.

Attach
Loads an existing stem list file. The loaded stem list replaces any current stem
list. The existing crown is divided amongst the stems using the generated
Voronoi tesselation. Where crowns belonging to either LA or TSD files can
be attached, stem lists must be loaded from stem files only. All stems
previously associated with the TSD file will be deleted before this operation
begins.
Stem Attach File Prompt

This dialog box prompts the user for the name of the stem list. The stem list
data is read from the file and interpreted. The appearance of the dialog box
used to input the file name will vary depending on the version and
configuration of Windows .
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The following error messages may occur when a stem list is merged. The
user can choose to continue or abort the "attach stems" operation, and choose
whether to be notified of any other errors of this type.

Once stems have been attached, the program will prompt the user to remove
any stems which have no impact on the plot. The program then decides which
stems have no impact on the plot based on the Voronoi regions associated with
each of the stems. If the Voronoi region of a stem does not overlap with the
area defined by the bounding rectangle of the map file associated with this
TSD, the stem will be removed.
Save
The current stem list file is saved to the disk. If it is a newly created stem list
file, the program will pop-up the Save As dialog box, and the user will be
prompted for a new file name.
Save As
The current stem list is saved to the disk. The user is prompted for the name
of the file. The current file name is supplied as a default. The user can
override the default and save the data in a different file.
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Automatic Renumbering
Selecting this option causes the list of stems to be renumbered consecutively
to account for gaps in the numbers given to stems, which may occur when
invalid stem are discovered on input or when stems are deleted from the list.
Remove Extra Stems
Removes any stems which do not impact on the defined crown space (i.e.,
those that are beyond the TSD plot area).
Collect LA from Merged Data
Instead of using pre-defined equations to calculate the leaf area for the stems
in a TSD, the program collects the leaf areas associated with each stem by
adding up each cubic metre associated with that stem.
Once crowns have been generated (from the Crown menu), this item is
disabled, as the program no longer has access to the merged data.
Clear
Removes all of the stems from the current tree stand file. This allows the user
to remove all existing stems in preparation for manual stem entry.
Entering, Deleting and Editing Individual Stems
The user may input, remove or modify data for individual trees in the dataset.
Selecting Enter, Delete or Edit causes a check mark to appear on the menu
beside the mode selected and the program to enter into the selected mode. The
modes are mutually exclusive, so only one may be selected at a time. Clicking
in the active window causes a dialog box to appear to perform the commands
listed below. The program stays in that mode until the check-mark is
removed. To remove the check mark, either select the command again or
select a different mode.
Enter

In this mode, the user can enter the properties of a new stem to be added to the
tree list. The Index field is a user-specified name for a given stem. If the
Height Specified box is unchecked, values cannot be entered in the HTCB,
Extent, and Leaf Area fields. If the Extent Specified box is unchecked,
values cannot be entered in the Extent or Leaf Area fields. If the Leaf Area
Specified box is unchecked, values cannot be entered in the Total Leaf Area
field. Any values not explicitly specified by the user will be calculated by the
program.
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Edit

A dialog box similar to the Enter dialog box will appear. In this mode, the
user can change one or more of an existing stem’s properties. By changing the
Index field, the user can modify a different stem, however, any changes made
to the previous stem will be lost. If no stems exist, a message box will pop up
advising the user of this. If stems are visible, the selected stem will be
highlighted in yellow. The check-boxes within this dialog box and the fields
they enable are the same as those in the Enter box.
When editing stems which have had their leaf area determined using the
Collect LA from Merged Data method (see page 68), the program will revert
back to using a pre-defined equation to calculate the leaf area if the Leaf Area
Specified box has been checked (allowing users to modify the leaf area), and
then subsequently unchecked.
Delete

A dialog box similar to the Enter dialog box above will appear. In this mode,
the user can remove a stem from the tree list. If no stems exist, a box will pop
up advising the user of this. Only the Index field can be changed in order to
specify the correct stem to delete. If stems are visible, the selected stem will
be highlighted in yellow on the display of the current stand map.
Show Stem Positions
Draws the stem map on the display of the current stand map. A brown circle
will appear on the stand map at the location of each stem in the stand. The
stem map will always appear on top of any other objects the user has
requested.
Stem File List
The four most recently attached or saved stem files are listed. The user may
open one of these files by selecting it.
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5.2.5 View Menu
The options on this menu allow users to change the look of the display.
Selecting Toolbar or Status Bar causes a check mark to appear beside the
option on the menu. These options can be selected at the same time, allowing
the user to display both on the screen. Values to Display changes what data
is displayed in the current window. Orientation of View changes what part of
the data is displayed in the current window. These menu items are mutually
exclusive within their section (only one view and one type of data may be seen
in a window at a time). Display Options annotates the display of the current
window. Display Method controls how the data is displayed. None, one, or
many of these options can be selected at a time. Display Settings gives the
user a centralized location (a single dialog box) from which to modify all the
view-options at once.

Toolbar
Selecting this item from the menu will toggle the toolbar on the main window.
The toolbar, a group of buttons located directly under the main menu, can be
used for quick access to commonly used commands if the user has a pointing
device such as a mouse or Glidepoint .
Status Bar
Selecting this item from the menu will toggle the status bar. The status bar,
located at the bottom of the main window, provides information about the
active document or highlighted command and also shows the state of the
CapsLock, NumLock and ScrollLock keys.
Values to Display
Selecting this menu item brings up a list of options from which the user can
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specify the data to be displayed. Only one option, which will have a check
mark beside it, can be selected at a time.
LA (Leaf Area)

Draws a map of LA on the screen. The LA is calculated for each square meter
of the current view and is displayed in the current window. The LA view is a
one metre thick horizontal or vertical slice of the canopy.
LAI (Leaf Area Index)

Draws a map of LAI on the screen. The LAI is calculated for each square
meter of the current view and is displayed in the current window. LAI is
defined as the sum of the LA above the current display elevation.
# Measurements per Cube

The number of measurements or observations that were used to determine the
LA of each cube is displayed in the current window. This option displays
values for a one metre thick horizontal or vertical slice of the canopy.
PPFD (Photosynthetic Photon Flux Density)

Draws a PPFD map on the screen based on the user’s current perspective
selection. The PPFD map shows the amount of instantaneous PPFD
penetrating to the centre of each cubic metre of the user's canopy. In general,
this is a time consuming computation and may take a long time to complete.
As a rule, it is not an interactive activity and can take anywhere from several
minutes to hours to complete. Very large plots on slower computers may take
more time to compute than most users are willing to wait. Because of the time
involved, the program will pop up a message box with an approximation of the
time it will take to complete the operation. This is an approximation based on
timing the calculations of three sample points and using this as a base-line to
estimate the time required to complete the calculations for all points in the
canopy.

% PPFD Transmittance

Draws a map of % transmittance on the screen based on the user’s current
perspective selection. This map shows the percentage of open sky PPFD
penetrating to the centre of each cubic metre of the user's canopy. This is a
non-interactive, time-consuming computation, and can take anywhere from
several minutes to hours to complete. Very large plots on slower computers
may take more time to compute than most users are willing to wait. Because
of the time involved, the program will pop up a message box with an
approximation of the time it will take to complete the operation. This is an
approximation based on timing the calculations of three sample points and
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using this as a base-line to estimate the time required to complete the
calculations for all points in the canopy.

Orientation of View
Selecting this menu item brings up a list of options, from which the user can
choose a particular "orientation" (horizontal or vertical) for the data. Only one
option, which will have a check mark beside it, can be selected at a time.
Horizontal View

This choice will draw a map of a plane parallel to the earth’s surface
intersecting the canopy. The user is prompted to select the height of the view
above the ground in metres. The maximum and minimum crown heights are
displayed in the dialog box to assist the user in making their selection. The
program then displays the data values (LAI, LA or # of measurements) of the
layer of cubes that are the selected distance above the ground.

Vertical View

This choice will draw a map of a plane perpendicular to the earth’s surface
intersecting the canopy. The plane must be parallel to one of the user’s axes.
The user is prompted to select either Up to Down (parallel to the Y-axis) or
the Left to Right (parallel to the X-axis), and the Coordinate (distance from
the origin) of the view in metres. The plot boundaries are displayed in the
dialog box to assist the user in making their selection. The program displays
the data values of the wall of cubes that are the selected distance from the
origin of the plot.

Display Options
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Selecting this menu item brings up a list of options from which the user can
choose various elements to display as part of the output. Any options which
were selected will have a check mark displayed beside them on the menu. If
the user subsequently deselects an option, the check mark associated with that
option will be erased. More than one option can be selected at a time,
allowing the user to overlay various elements on the screen display, or on the
printed output.
Show Stake Positions

Displays the positioning of the observation points read from the map file.
These are the points at which the canopy heights are measured and the LAI
2000 PCA readings were taken in the stand. Typically, stakes are driven into
the ground at these points.
Show Stem Positions

Draws the stem map on the display of the current stand map. A brown circle
will appear on the stand map at the location of each stem in the stand. The
stem map will always appear on top of any other objects the user has
requested.
Show Legend

Displays a shading legend consisting of eight display values (either colours or
patterns) and the actual data values used to create the display values. The
shading legend is displayed beside the actual display. Although only eight
colours are shown on the legend, sixty-four colours are actually used to paint
the display map.
Show Ruler

This option will display a border around the display of the plot. The border is
annotated with the size of the plot. This is useful when attempting to
determine the location of artifacts in the plot or when deciding offsets and
distances for views.
Display Method
Selecting this menu item brings up a list from which the user can control how
the data is displayed. Any options which have been selected will have a check
mark displayed beside them on the menu. If the user subsequently deselects
an option, the check mark associated with that option will be erased. More
than one option can be selected at a time, allowing the user to overlay colours,
patterns, and isolines on the screen display, or on the printed output.
Colour

Shades the map in the current window with colour. Colours do not overwrite
patterns nor isolines. Colours will not appear on printed output. Instead,
colours will be translated to patterns or grey scales.
Pattern

Uses patterns to shade the current map. Patterns are drawn over colours on
the screen but not over the isolines.
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Isolines

Puts isolines on the current map. Isolines are drawn over any colours or
patterns currently on the screen.
Smoothing

If Colour has been chosen as a display method, choosing Smoothing will blur
the boundaries between the different colours, resulting in a much smoother
looking output.
Display Settings
As an alternative to menu toggles, a dialog box is available to make many
changes to the display from a centralized location.

5.2.6 Window Menu
The Window menu presents users with standard MDI options to control
windows created by the program. The New Window option creates a copy of
the selected window. The Cascade option arranges all of the open windows
from the top left to the bottom right of the main program window. This allows
all of the title bars to be easily read. The Tile Horizontal and Tile Vertical
options arrange the open windows as smaller tiled windows in the main
program window. These option are useful for seeing a piece of each of the
open windows. The Arrange Icons option aligns all of the iconic
(minimized) windows in a row at the bottom of the main program window.
The Information Window toggles a window with information about the
selected map. The bottom section of this menu shows all of the open files,
whether in an open window or in icon form. The user can select the file of
choice using the mouse or the keyboard. The selected window is opened (if
minimized), brought to the front, and receives the input focus.
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New Window
Creates a copy of the current window and gives it the input focus. The user
can then select a different view of the same stand. This is the standard
Windows tool for allowing a user to create a new view of the same document.
Cascade and Tile Selections
The Cascade selection causes all of the open windows to be cascaded inside
the main application window. After windows have been cascaded, their title
bars and system menus are visible and accessible, allowing the user to easily
find and display a particular one.
The Tile selection causes all of the open windows to be tiled either
horizontally or vertically inside the main application window. This is useful
for displaying two or more windows at their maximum size simultaneously.
The user selects the format, vertical or horizontal, that is most appropriate for
viewing their data. If the user has more open windows than they wish to tile,
they must minimize the excess windows (making them icons) before selecting
Tile.
Arrange Icons
This selection causes all of the minimized windows (icons) inside the
application window to be arranged neatly along the bottom of the application
window.
Information Window
This dialog displays basic instantaneous values for a point on the map. From
this dialog, the user may specify a different point and a different time for
instantaneous calculations (duration of one second). The user may also
examine the closest stem to the specified location. The user also has the
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ability to display the below canopy photograph for the specified location.
This dialog can also be accessed by clicking directly on a point in the map
window.

PPFD Information Dialog

This dialog, accessed by pressing the button to the right of the PPFD label on
the Information window, is the same as that of the PPFD Information
window, described below.
Location Dialog

From this dialog, accessed by pressing the Location button on the
Information window, information can be entered to pinpoint a specific map
location. The user is prompted to enter the X and Y coordinates (where 0,0 is
in the lower, left-hand corner of the map), along with an elevation. Any
numbers entered which are out of range will be modified to fit the range of
valid data.

Date and Time Dialog

This option, accessed by pressing the "date" button (the one with a date on it)
on the Information window, allows the user to specify the local date and time
used to calculate instantaneous PPFD values. Time must be entered in
standard Windows™ time format (hours:minutes:seconds).
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Closest Stem Dialog

This dialog is displayed when the user presses the Closest Stem button on the
Information window, and displays the properties of the stem closest to the
specified point. No fields can be modified by the user.

PPFD Information Window
The PPFD information window provides more detailed information about
PPFD values, including the sun location, as well as the break-down of total
PPFD to total above and below canopy PPFD. All PPFD calculations take
into consideration parameters such as tree species types and leaf in and drop
periods. The beam component is calculated from the exact sun location over
the plot. (For long-term calculations, the beam component of the total PPFD is
placed in the closest of the 480 sky brightness chart cells.)
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Location Dialog

This dialog, accessed by pressing the Location button on the PPFD
Information window, is the same as that accessed via the Information
window.
Date and Time Dialog

This dialog, accessed by pressing the "date" button (the one with a date on it)
on the PPFD Information window, is the same as that accessed via the
Information window.
Canopy Photograph

This option, accessed by pressing the Canopy Photograph button on the
PPFD Information window has the same effect as using the Below Canopy
Photograph menu option, described below.
Below Canopy Photograph
A below canopy photograph represents a view of the canopy coverage,
regardless of the time of day or year. The foliage amounts displayed are for
full leaf out. This is discussed in more detail in the section on Page 80.
Longterm PPFD Calculations
Instantaneous calculations are not always sufficient, so the user has the ability
to perform long-term calculations which also take into account parameters
such as tree species types, leaf in and drop periods, etc. The user can specify
the start and end times for the calculation, as well as the accuracy. If the user
requests a calculation to cross a yearly boundary, he will be warned, since this
type of calculation isn't typical.
The beam components of total PPFD are placed and accumulated in the
closest of the 480 sky brightness chart cells, described later (for instantaneous
calculations, the beam component is calculated from the exact sun location
over the plot).

Date and Time Dialog

This option, accessed by pressing the Start and End buttons on the Longterm
PPFD Calculations window, allows the user to specify the start and stop time
used to calculate long-term PPFD values. Time must be entered in standard
Windows™ time format (hours:minutes:seconds).
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Location Dialog

From this dialog, accessed by pressing the Location button on the
Information window, information can be entered to pinpoint a specific map
location. The user is prompted to enter the X and Y coordinates (where 0,0 is
in the lower, left-hand corner of the map), along with an elevation. Any
numbers entered which are out of range will be modified to fit the range of
valid data.

5.2.7 Help Menu
This menu displays program information and supports the user with on-line
help. Index brings up a list of topics pertaining to LITE. Using Help brings
up information on how to use the Help menu system. About LITE brings up
the about-box for the program.
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Index
Displays the Contents page for the LAI 2000/Tree Stand Modelling Help.
The user can choose one of the topics by clicking on it with a pointing device
or by selecting it with the Tab key and then pressing Enter.
Using Help
This is a standard feature in the Windows environment. It explains how to
use Help.
About LITE
Displays information about the program, including the version number,
copyright and license.

5.3 Below Canopy A below canopy photograph presents another method of viewing the data in the
TSD file. It represents the canopy found above a specified point in the map at
Photographs
full leaf-out. As long as the canopy photograph remains the active window, the
menu items will be different because it is a different representation of a TSD
file. While the Window and Help menus remain the same, there are no
Atmosphere, Crown or Stems windows, and the File and View menus are
different as described below.
5.3.1 File Menu
The file operations remain the same, but are restricted to a subset of the
generic TSD display because it is another representation of a TSD file. For
example, one cannot export a below canopy photograph to a file.
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5.3.2 View Menu
The view menu allows the user to determine how the canopy photograph will
appear.

Toolbar
Selecting this item from the menu will toggle the toolbar on the main window.
The toolbar, a group of buttons located directly under the main menu, can be
used for quick access to commonly used commands if the user has a pointing
device such as a mouse or Glidepoint .
Status Bar
Selecting this item from the menu will toggle the status bar. The status bar,
located at the bottom of the main window, provides information about the
active document or highlighted command and also shows the state of the
CapsLock, NumLock and ScrollLock keys.
Global/Local Colour Scaling
Users can select between global and local colour scaling. Selecting one will
de-select the other (with global colour scaling being the default). Global
colour scaling uses shades ranging from white (representing no canopy) to
black (thickest canopy). With local colour Scaling, the range is from white
(thinnest canopy) to black (thickest).
View Cell Boundaries
The user has the option to turn off the cell boundaries (grid-lines) of the
canopy photograph. By default, they are turned on, and the associated menu
item will have a checkmark beside it.
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5.4 Calculations
and Algorithms

5.4.1 Radiation
Above Canopy Radiation
The amount of radiation reaching a point directly above the canopy is a
function of:
1. the position of the sun in the sky (solar time);
2. the amount of extraterrestrial radiation; and,
3. atmospheric conditions (pollution, clouds, etc).
Solar Time

Solar time is the time of day based on the position of the sun. Solar noon
occurs when the sun is at its apex in the sky, and is different from local time.
The solar time of the plot is calculated from local time, the timezone of the
plot, and the longitude of the plot. Local standard time is corrected to
determine Greenwich Mean Time (GMT) using the timezone. GMT is the
solar time at longitude 0. Solar time at the plot is then calculated based on the
longitude, which is the number of degrees of separation between 0 and the
plot.
Extraterrestrial Radiation and Atmospheric Conditions

The formula s and constants in this section are drawn from Spitters et al.
(1986). Total extraterrestrial radiation is set to 1370 J/(m 2s) and converted to
2596.15 µmoles/(m2s) of PPFD by multiplying with a conversion factor of
2.04 (Meeh et al., 1984). Atmospheric conditions are based upon readings of
instantaneous PPFD values (in µmoles/m2s) recorded at one (1) hour intervals
at a weather station.
The ratio of these measured PPFD values to the maximum expected PPFD
is calculated for a given point in time. Maximum values are determined using
formula (1) from Spitters et al. (1986) and the solar time. This calculated
atmospheric transmission value is then used as the ratio of global PPFD above
canopy to extraterrestrial PPFD (Sg/So) in formula s (20a-d). The result is a
fraction diffuse value for radiation.
Ratio of Measured PPFD Above
Canopy to Extraterrestrial PPFD
(Sg/So)

Diffuse fraction of
Total PPFD
(Sd/Sg)

Sg/So < 0.07
0.07 <= Sg/So < 0.35

Sd/Sg = 1
Sd/Sg = 1 – 2.3(Sg/So – 0.07)

0.35 <= Sg/So < 0.75
0.75 <= Sg/So

Sd/Sg = 1.33 – 1.46 Sg/So
Sd/Sg = 0.23
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where:
Sd = diffuse irradiation above canopy
Sg = global (total) irradiation above canopy
So = extraterrestrial irradiation (a function of solar altitude and date)
The fraction, Sd/Sg, is used to separate the measured PPFD values into
direct and diffuse above canopy values.
Direct Beam Radiation
The amount of direct radiation reaching a point in or under the canopy is a
function of:
1. above canopy direct radiation;
2. direct beam path; and,
3. canopy conditions such as tree leaf area and tree species.
Direct Beam Path

The sun's position is used to determine the path of the direct radiation through
the canopy of the stand. The cubes affecting the direct radiation can be
determined along with the path length of the radiation through each cube.
The position of the sun is characterized by two angles from the reference
point in the stand. The azimuth of the sun, α, is its compass direction in
degrees and the elevation of the sun, β, is the number of degrees above the
horizon. Note that β is not the same measure as used in the LAI 2000 device,
which uses the number of degrees from the zenith.
The sun's azimuth, α, and elevation, β, at time of day th are calculated by:

[

]

cos λsin 15(th − 12) 

α = sin − 1 
cos β





and

[

[

]]

β = sin − 1 sin λsin δ+ cos λcos δcos 15(t h − 12)

where

λ = latitude in degrees of the site
δ= solar declination in degrees calculated by
360( t d + 10)
sin δ= − sin (2345
. )cos 

365




t d = number of days since January 1st
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Canopy Conditions

Once the amount of direct radiation reaching the top of the canopy, Pbo, and
the path through the cubes forming the canopy has been determined, the
amount of direct radiation reaching a point z under the canopy, Pbz can be
determined using Beers law (Norman and Welles, 1983):
Pbz = Pbo e∑ i

− Gi li di

where
Gi is the light projection coefficient for the species in cube i
For broadleaf species, Gi is a constant that can be altered by
the user (see, Leaf Coefficients page 55).
For Douglas-fir, Gi is determined with a function derived
from Black et al. (1991) and cannot be altered by the user.
li is the leaf area in cube i (m2 / m3)
di is the path length through cube i
Diffuse Radiation
The amount of diffuse radiation reaching a point in or under the canopy is a
function of:
1. above canopy diffuse radiation; and,
2. canopy conditions such as tree leaf area and tree species.
Canopy Conditions

Once the amount of above canopy diffuse radiation, Pbo, has been determined,
the amount of diffuse radiation reaching a point z under the canopy, Pbz, can
be determined in a manner similar to the direct radiation. Rather than
measuring the extinction of radiation along the path of a single ray, the total
diffuse radiation is distributed evenly among 480 sample rays, assuming
isotropic distribution of diffuse light, in the hemisphere. The total diffuse
radiation is estimated by summing the radiation of these 480 rays.
The sample rays are the centres of equal areas of the hemisphere. The
hemisphere is divided into 20 divisions from zenith to horizon (altitude) and
24 divisions of azimuth. The centre of the area is defined as the midpoint of
the altitude angles and azimuth angles subtending the region.
Within the program, there is a user-specified horizon. It is assumed that
any radiation below this horizon would be blocked by stems, branches, and
geographic features. By default, approximately the bottom 10 degrees are
occluded.
Each sample ray used is tracked through the canopy to determine which
cubes it intersects and for what length. The species information of each cube
is used to extinguish the sample ray. The calculation for each ray is the same
as for the direct beam calculation detailed in the prior section.
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5.4.2 Calculation of Exported Values
The calculation for all periodic values, either being sky brightness charts,
above canopy readings, or below canopy readings are all performed at the
same time. The calculations are performed in this manner because of the
iterative nature of the calculations and the dependencies among them. The
following section describes what kind of data can be exported. The second
section outlines, in general, design decisions relating to the calculation of
these values.
Definitions
Sky Brightness Chart

A sky brightness chart is a representation of the total sky intensity incident on
a horizontal surface over a time period specified by the user. The sky
brightness chart is divided into 480 equal-area divisions of the sky hemisphere
(Canham et al. 1994). LITE's representation of a sky brightness chart keeps
the diffuse and beam portions separate to correctly calculate the %
transmittance. An example of a calculated sky brightness chart output can be
found in Appendix D - Sky Brightness Chart, page 94.
As shown in the example, the sky is divided into 24 regions horizontally
and 20 regions vertically to provide a total of 480 regions. Borders between
regions are not spaced equally to ensure that all regions have the same area.
The degrees mark the centre of the regions in the given plane.
For the calculation of a sky brightness chart, the user must specify:
• the azimuth of the plot, which is specified in the map file used to create the
TSD file, and not modifiable by the user;
• global location, time zone of the plot, which is normally specified when the
TSD file was created, but may be modified at any time;
• start and end times for the calculation, specifying the period that the sky
brightness chart will represent; and,
• the calculation interval, used to specify how often the position of the sun is
to be calculated.
The output of a sky brightness chart specifies details such as start and end
times, calculation intervals, and location of the plot for future reference. The
output also provides the total accumulated beam and diffuse PPFD for the
specified time period. The table illustrates the locations of the beam
components of the PPFD. For calculations, total diffuse PPFD is divided
equally among the 480 regions. This value is also provided.
Above Canopy Readings

Above canopy readings are calculated from the same information used to
calculate sky brightness charts. These readings represent total PPFD reaching
the point just above the canopy, so attenuation through the atmosphere has
been accounted for. An example of the output of above canopy readings can
be found in Appendix E - Above Canopy Readings, page 95.
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To calculate above canopy readings, the user must specify the same values
for the calculation of the sky brightness chart, as well as:
• the output interval, which specifies the period of time between outputs to
the file. The output interval is always a multiple of the calculation interval,
to simplify internal logic. Separating the calculation interval from the
output interval allows the user to specify greater accuracy without the same
volume of output (e.g., calculation interval of 15 minutes but output data
once per day).
The output of this file directly corresponds to the matching sky brightness
chart. The sum of all beam and diffuse PPFD (given for each output time
interval) will match the total beam and diffuse components in the
corresponding sky brightness chart.
Each entry represents accumulated diffuse, direct, and total PPFD, and the
average sun location for the time period and interval specified. The date and
time represent the mid-point of a time period. For example, the entry for Jan 1
for the time period from 08:15:00 to 08:30:00 is 08:22:30, since the output
interval is 15 minutes.
Below Canopy Readings

Below canopy readings represent the amount of PPFD which penetrates the
canopy at a point specified by the user. This point does not necessarily have
to be at the canopy floor. An example of the output can be found in Appendix
F - Below Canopy Readings, page 96.
To calculate below canopy readings, the user must specify the same values
for the calculation of above canopy readings, plus:
• the location within the plot specifying the point for which below canopy
readings are to be calculated. This may actually be above the canopy,
which results in below canopy readings being relatively equal to above
canopy readings; and,
• stems (which must each be associated with a species type), and a default stem
species type for the plot. This species information is normally taken from
application defaults upon creation of the TSD file, and may be modified by the user.
This information is used to determine leaf in and leaf drop times, and to determine
the light projection coefficient for the species. Again, all these values may be
changed by the user. Stems may be attached in bulk, and individually entered,
modified, and removed in other portions of LITE.
Output values correspond to values in above canopy output. The final
column represents the GLI for the period, or percentage of the PPFD traveling
through the canopy.
Calculation of Periodic Values
Before any calculation takes place, start and end dates are checked. If the
period specified by the user crosses a year boundary, the user is warned and
asked whether to continue.
Start and end times are given in local time, but are converted to solar time
when calculating sun positions. However, when calculating output PPFD for a
period of time, local time is used since sky condition PPFD values are loaded
and stored in local times. Finally, all output is given in local time to avoid
confusion among the times specified by the user and times given in the output.
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For each calculation interval, the local time and plot location are used to
calculate a solar time which is converted into a sun location (elevation and
azimuth). The total above canopy PPFD is determined either by interpolation
of input values from the .pfd file (see Open Sky PPFD File (*.pfd) on Page
42) or calculated by using the sun's elevation and atmospheric conditions
previously set by the user. The sun location is then used to:
• separate the total PPFD for the calculation interval into diffuse and direct
PPFD; and,
• to identify the location of the beam in the sky brightness chart.
For long-term calculations, the beam component of the total PPFD is placed
in the closest of the 480 sky brightness chart cells, and accumulated over the
entire time specified by the user. These accumulated values are shown in the
example sky brightness chart output, above.
The algorithms used to calculate below canopy readings take into
consideration leaf in and leaf drop times. For each week during the period
between leaf in and leaf drop, the average amount of leaf area is calculated
and used when determining the amount of canopy to use as a filter for above
canopy PPFD. Leaf in and drop dates are specified for each species, and can
be inspected and modified by the user.
The “below canopy readings example” shows that the percentage is very
high, but never 100%. The reason for this is because there is no leaf area
(after leaf drop, before leaf in) for the species in January. The value never
reaches 100% because the bottom three rings (72 of the 480 regions) of the
sky brightness charts are always excluded from the calculation of below
canopy readings. However, they are present in above canopy sky readings and
in the sky brightness chart. The reasoning for this is because these rays extend
out at extremely low angles from horizontal, thus making these values rather
inconsequential, due to the amount of atmosphere and canopy through which
these rays must travel. Currently, the user may not modify this design
decision.
If the calculation interval is less than the output interval, all calculated
values are accumulated until the next output interval occurs. All values for a
calculation interval are calculated from the mid-point of the interval as an
instantaneous value and multiplied by the number of seconds in that interval.
For example, if the interval is 15 minutes, at 8:00am, the sun position and
PPFD will be calculated for 8:07:30am. Thus, changing the calculation
interval affects both the accuracy of the calculation and the time required to
perform the calculation.
If the start and end times for the calculations do not specify an integral
number of intervals, for example the interval is 15 minutes, but the time period
between start and end times is 55 minutes, then the final calculation interval is
adjusted to correct this. The start and end times are not adjusted to match
intervals. So, in this example, the last interval will be 10 minutes in length,
starting at 45 minutes, ending at 55 minutes, and the sun location will be
calculated at 50 minutes.
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5.4.3 Crown Generation
Crowns are generated for all stems attached to a plot, even if the stem is
outside of the plot boundaries. This ensures areas in the plot which are
associated with stems that reside outside of the plot still receive appropriate
LA values.
The crowns are defined by four quarter-ellipses. Each ellipse shares major
and minor axes with its two neighbours. The major and minor axes are
defined by the crown extent measurements for each of the four cardinal
directions, as shown below:
N

W

E

S

The crown is divided into upper and lower sections using the ratio of the
crown belonging to the upper half. The vertical crown curvature for both
these sections is defined by the power-factor for the upper and lower sections
of the crown. This information is provided by the user through the Tree
Morphology Coefficients dialog box, and is constant for all four quartersections.
The diagram below shows several sample vertical crown curvatures for an
upper crown section. A power factor of 1.0 corresponds to a straight line. A
factor of 2.0 results in an ellipse. If the factor is greater than 2.0, the crown
curve will become more convex and eventually rectangular as the factor
approaches infinity. Conversely, a factor of less than 1.0 will produce a
concave crown curve (Koop 1989).
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Voxels, or volume-elements (in this case one-metre cubes), that lie within
the boundaries of the formulas which define the crown are marked and added
to a list of voxels owned by the stem.
The total LA to be associated with the stem/tree is calculated from the
following equation:
LA = 2.0 * foliage_biomass * 1000 *s_LA / 100 / 100 * sin(leaf_angle)
where:
2.0=Leaves are double-sided.
* foliage_biomass(species_index, diam, height)=
Foliage biomass is calculated as a function of the stem's
species type, its diameter, and its height. The height may be
calculated from the diameter.
* 1000=Converting from grams to kilograms.
* s_LA=Specific leaf area (constant for a species).
/100 /100=Converting from cm2 to m2
* sin(leaf_angle)=Leaf angle (constant for a species).
Once the total LA to be associated with a stem has been calculated, it is
divided by the total number of voxels associated with the crown space,
whether they exist or not (to ensure the proper density for each voxel). The
calculated density is assigned to each voxel which exists for the tree and the
voxel is associated with that stem.
Each voxel can only be associated with one stem. If a voxel lies within the
crown-space of more than one stem, it will remain associated with the last
stem (where stems are processed in numerical order)
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APPENDICES

Appendix A - Open Sky PPFD File (*.pfd)
[Day]
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147
147

[Time]
0
100
200
300
400
500
600
700
800
900
1000
1100
1200
1300
1400
1500
1600
1700
1800
1900
2000
2100
2200
2300

[PPFD]
0
0
0
0
0
29.2
182.9
451.9
767
1075
1330
1558
1659
1668
1563
1046
660.7
653.1
359.6
161.2
31.06
0
0
0
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y
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
4.12
3.99
4.45
3.61

3.74
3.83
4.55
3.45

3.74
4.03
4.72
3.80

4.11
3.64
4.45
3.89

8.0
8.3
9.9
7.3

2.85
4.08
3.77
4.06
4.11
3.67
3.74

2.96 2.90 2.15 2.76

2.48
4.85
4.49
4.18
4.12
3.50
4.14

3.1

2.41
3.35
2.44
4.39
3.84
3.00
4.33

1.96
4.93
3.83
4.42
4.00
3.26
3.71

3.9
11.9
10.3
10.4
9.4
6.3
8.7

3.13
3.54
4.88
3.54
3.42
3.98
3.77
3.13

3.64 3.64 2.79 3.49
3.72 3.64 3.28 4.04

3.32
2.90
4.06
3.10
3.32
4.17
3.81
2.70

5.8
7.2

0.00
3.44
4.82
3.78
3.43
3.74
3.43
3.65

3.37
3.18
4.49
3.24
2.96
3.61
3.89
3.45

7.5
7.2
10.7
6.7
5.7
7.9
6.9
6.0

diam. lean_% lean_dir. [ height [ htcb{n, e, s, w}

74
DR
13.05 6.11 4.05
75
DR
10.45 7.21 3.69
76
DR
10.94 9.54 9.00
77
DR
10.50 9.88 3.32
78
DR
11.47 9.08 2.55
79
DR
12.29 9.29 4.46
80
DR
12.14 8.89 3.47
81
DR
11.67 8.19 2.78
82
DR
12.07 8.29 1.98
83
DR
12.25 8.09 2.59
84
DR
12.50 7.98 3.75
85
DR
13.60 8.36 8.24
86
DR
13.56 8.67 4.73
87
DR
13.59 8.85 4.07
188
DR
21.62 14.35 1.89
246
DR
17.93 14.43 7.12
248
DR
16.44 13.91 2.66
262
DR
13.73 9.94 1.46
265
DR
13.31 10.82 2.46
266
DR
9.79 11.48 1.62
267
DR
11.91 15.10 12.20
268
DR
11.10 15.97 8.22
269
DR
11.14 13.97 8.27
270
DR
12.52 13.53 6.43
271
DR
12.02 12.20 2.95
272
DR
11.50 12.11 5.38
273
DR
12.79 11.37 1.38
274
DR
12.27 11.09 2.11
275
DR
12.02 11.19 1.33
277
DR
14.01 12.13 11.00
280
DR
11.94 11.30 1.92
281
DR
11.60 10.79 4.57
282
DR
9.44 9.66 4.97
283
DR
8.64 10.26 7.32
284
DR
8.14 9.65 3.86
[...remaining entries omitted]

Stem list: version 4
Elements: 636
Format:
Stem_ID Species x

1.49
1.17
1.84
0.96
0.76
1.32
1.11
0.77

1.29
1.24
1.99
1.11
0.79
1.18
1.01
0.98

1.31
1.16
1.82
1.04
0.76
1.26
1.02
0.93

0.48
2.33
2.01
1.86
1.68
1.01
1.37

0.47
2.18
1.83
1.89
1.64
0.92
1.43

0.39
2.28
1.93
1.90
1.64
0.85
1.51

1.25
1.45
1.71
1.11

1.24
1.38
1.71
1.19

1.34
1.42
1.68
1.22

1.35
1.37
1.60
1.14

0.00 0.09 0.32 0.18

0.53
2.17
1.92
1.85
1.66
0.97
1.52

0.66 0.66 0.91 0.75
1.13 1.15 1.21 0.98

1.28
1.21
1.93
1.09
0.86
1.34
0.97
0.86

4.47
6.04
5.69
10.91

4.89

8.87
14.36
33.47
11.67
11.63
6.55
5.65

3.83
4.53

4.90
21.10
4.54
5.89
5.59
5.43
4.35
4.92

[ radius{n, e, s, w} [ total_LA ]]]]
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Appendix C - Observation Point Map File (*.map)
; Azimuthal of (0,0),(0,1)
305
; Number of tags
40
;tag,x,y,htcb,httc
221, 8, 5, 6.1, 11.5
222, 8, 15, 6.1, 11.5
223, 8, 25, 6.1, 11.5
224, 8, 35, 6.1, 11.5
225, 8, 45, 6.1, 11.5
226, 8, 55, 6.1, 11.5
227, 8, 65, 6.1, 11.5
228, 8, 75, 6.1, 11.5
229, 24, 5, 6.1, 11.5
230, 24, 15, 6.1, 11.5
231, 24, 25, 6.1, 11.5
232, 24, 35, 6.1, 11.5
233, 24, 45, 6.1, 11.5
234, 24, 55, 6.1, 11.5
235, 24, 65, 6.1, 11.5
236, 24, 75, 6.1, 11.5
237, 40, 5, 6.1, 11.5
238, 40, 15, 6.1, 11.5
239, 40, 25, 6.1, 11.5
240, 40, 35, 6.1, 11.5
241, 40, 45, 6.1, 11.5
242, 40, 55, 6.1, 11.5
243, 40, 65, 6.1, 11.5
244, 40, 75, 6.1, 11.5
245, 56, 5, 6.1, 11.5
246, 56, 15, 6.1, 11.5
247, 56, 25, 6.1, 11.5
248, 56, 35, 6.1, 11.5
249, 56, 45, 6.1, 11.5
250, 56, 55, 6.1, 11.5
251, 56, 65, 6.1, 11.5
252, 56, 75, 6.1, 11.5
253, 72, 5, 6.1, 11.5
254, 72, 15, 6.1, 11.5
255, 72, 25, 6.1, 11.5
256, 72, 35, 6.1, 11.5
257, 72, 45, 6.1, 11.5
258, 72, 55, 6.1, 11.5
259, 72, 65, 6.1, 11.5
260, 72, 75, 6.1, 11.5
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Beam Component by
elevation 1.4
azimuth
82.5
0.0
67.5
0.0
52.5
0.0
37.5
0.0
22.5
0.0
7.5
0.0
352.5
0.0
337.5
0.0
322.5
0.0
307.5
0.0
292.5
0.0
277.5
0.0
262.5
0.0
247.5
0.0
232.5
368794
217.5
0.0
202.5
0.0
187.5
0.0
172.5
0.0
157.5
0.0
142.5
0.0
127.5
113629
112.5
0.0
97.5
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
960475
0.0
0.0
0.0
0.0
670756
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
271890
0.0
0.0
0.0
0.0
0.0
0.0
344295
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
723033
0.0
0.0
0.0
0.0
506696
0.0
0.0
0.0

10.1

S.B.C. Cell:
4.3
7.2
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
567006
622830
0.0
0.0
434924
395822
0.0
0.0
0.0

13.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
2052392
1437187
576635
1525863
0.0
0.0
0.0
0.0

16.0

Start time (local): Jan 1 04:00:00
End time (local):
Jan 2 04:00:00
Interval for calculations:
00:15:00
Location of plot:
Latitude:
49.0 North
Longitude: 123.0 West
Azimuth of plot (geographic):
360.0
Total Beam for time period: 14862214.0
Total Diffuse for time period:
18444818.0
Total Diffuse per Cell for time period:
38426.6

Sky Brightness Chart in PPFD

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
1386300
1903590
0.0
0.0
0.0
0.0
0.0

19.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0
0.0

22.0 25.2 28.4 31.7 35.1 38.7 42.5 46.5 50.8 55.6 61.0 67.7 77.2

Appendix D - Sky Brightness Chart
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Jan 1 04:00:00
Jan 2 04:00:00
00:15:00
00:15:00

Location of plot:
Latitude:
49.0 North
Longitude: 123.0 West
Format:
Date
Time
[sun_horiz (geographic) sun_vert
(calculation is centered around interval_len)
Jan 1 04:07:30
[ … empty entries omitted for brevity…]
Jan 1 08:07:30
Jan 1 08:22:30 129.0
1.7
Jan 1 08:37:30 132.0
3.6
Jan 1 08:52:30 135.0
5.3
Jan 1 09:07:30 138.0
7.0
Jan 1 09:22:30 141.0
8.6
Jan 1 09:37:30 144.0
10.1
Jan 1 09:52:30 147.0
11.5
Jan 1 10:07:30 150.0
12.8
Jan 1 10:22:30 154.0
13.9
Jan 1 10:37:30 157.0
14.9
Jan 1 10:52:30 161.0
15.8
Jan 1 11:07:30 164.0
16.5
Jan 1 11:22:30 168.0
17.1
Jan 1 11:37:30 171.0
17.5
Jan 1 11:52:30 175.0
17.8
Jan 1 12:07:30 178.0
17.9
Jan 1 12:22:30 182.0
17.9
Jan 1 12:37:30 186.0
17.7
Jan 1 12:52:30 189.0
17.3
Jan 1 13:07:30 193.0
16.9
Jan 1 13:22:30 196.0
16.2
Jan 1 13:37:30 200.0
15.4
Jan 1 13:52:30 203.0
14.5
Jan 1 14:07:30 207.0
13.4
Jan 1 14:22:30 210.0
12.3
[…remaining entries are omitted]

Start time (local):
End time (local):
Calculation Interval:
Output Interval:

PPFD_beam

113629.8
152208.1
192087.7
232796.3
273900.2
315004.4
355752.2
395822.0
434924.0
472794.5
509189.8
543878.9
576635.3
607229.4
635419.0
660942.3
683508.5
702791.9
718424.8
718762.2
704029.8
685469.9
662892.2
622830.3
567006.6

total_PFD

569531.3
611718.8
653906.3
696093.8
738281.3
780468.8
822656.3
864843.8
907031.3
949218.8
991406.3
1033593.8
1075781.3
1117968.8
1160156.3
1202343.8
1244531.3
1286718.8
1328906.3
1350000.0
1350000.0
1350000.0
1350000.0
1321875.0
1265625.0

455901.5
459510.7
461818.6
463297.5
464381.1
465464.3
466904.1
469021.7
472107.3
476424.2
482216.4
489714.9
499145.9
510739.4
524737.3
541401.5
561022.8
583926.9
610481.5
631237.8
645970.3
664530.1
687107.8
699044.7
698618.4

PPFD_diffuse]

Appendix E - Above Canopy Readings
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49.0 North
123.0 West

Location of plot:
Latitude:
Longitude:
Location within plot:
(0.0, 0.0, 0.0)
Format:
Date
Time
[sun_horiz (geographic) sun_vert
total_percent]
(calculation is centered around interval_len)
Jan 1 04:07:30
[ … empty entries omitted for brevity…]
Jan 1 08:07:30
Jan 1 08:22:30 129.0
1.7
Jan 1 08:37:30 132.0
3.6
Jan 1 08:52:30 135.0
5.3
Jan 1 09:07:30 138.0
7.0
Jan 1 09:22:30 141.0
8.6
Jan 1 09:37:30 144.0
10.1
Jan 1 09:52:30 147.0
11.5
Jan 1 10:07:30 150.0
12.8
Jan 1 10:22:30 154.0
13.9
Jan 1 10:37:30 157.0
14.9
Jan 1 10:52:30 161.0
15.8
Jan 1 11:07:30 164.0
16.5
Jan 1 11:22:30 168.0
17.1
Jan 1 11:37:30 171.0
17.5
Jan 1 11:52:30 175.0
17.8
Jan 1 12:07:30 178.0
17.9
Jan 1 12:22:30 182.0
17.9
Jan 1 12:37:30 186.0
17.7
Jan 1 12:52:30 189.0
17.3
Jan 1 13:07:30 193.0
16.9
[…remaining entries omitted]

Jan 1 04:00:00
Jan 2 04:00:00
00:15:00
00:15:00

Start (solar time):
End (solar time):
Calculation Interval:
Output Interval:

PPFD_beam

0.0
0.0
0.0
0.0
0.0
315004.4
355752.2
395822.0
434924.0
472794.5
509189.8
543878.9
576635.3
607229.4
635419.0
660942.3
683508.5
702791.9
718424.8
718762.2

total_PFD

387514.9
390583.6
392546.8
393800.8
394724.1
710649.6
752621.4
794489.3
836216.7
877756.2
919075.8
960137.7
1000908.0
1041357.1
1081443.2
1121131.5
1160380.5
1199127.2
1237336.2
1255317.1

387514.9
390583.6
392546.8
393800.8
394724.1
395645.2
396869.2
398667.3
401292.7
404961.6
409886.0
416258.8
424272.7
434127.7
446024.2
460189.2
476872.0
496335.3
518911.4
536554.9

PPFD_diffuse

68.0
63.9
60.0
56.6
53.5
91.1
91.5
91.9
92.2
92.5
92.7
92.9
93.0
93.1
93.2
93.2
93.2
93.2
93.1
93.0

Appendix F - Below Canopy Readings
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7.000
1.209
0.000
1.008
0.296

23.00
0.638
0.000
1.087
0.500

7.000
0.928
0.000
1.008
0.392

23.00
0.537
0.000
1.087
0.558

APPENDICES

7.000
0.037
0.000
1.008
0.963

23.00
0.026
0.000
1.087
0.972

9.337
9.076

12.06
1.802

68.00
0.726
0.000
2.670
0.144

9.760
9.384

53.00
0.175
0.000
1.662
0.748

12.06
9.016

68.00
0.259
0.000
2.670
0.501

POINT
24

9.757
3.320

53.00
1.144
0.000
1.662
0.149

PLOT
H270B
38.00
0.031
0.000
1.270
0.961

DATE
TIME
10 JUL 08:21:02

A 43 08:21:25 10.93
B 1 08:21:23 10.53

ANGLES
CNTCT#
STDDEV
DISTS
GAPS

FILE
87

9.330
5.206

12.06
0.926
POINT
25

9.757
2.374

PLOT
H270B
38.00
0.849
0.000
1.270
0.340

DATE
TIME
10 JUL 08:20:51

A 42 08:20:55 10.92
B 1 08:20:56 4.286

ANGLES
CNTCT#
STDDEV
DISTS
GAPS

FILE
86

9.330
4.665

68.00
0.993
0.000
2.670
0.071

POINT
25
53.00
1.544
0.000
1.662
0.077

PLOT
H270B
38.00
1.113
0.000
1.270
0.243

DATE
TIME
10 JUL 08:19:47

A 42 08:20:55 10.92
B 1 08:20:42 3.227

ANGLES
CNTCT#
STDDEV
DISTS
GAPS

FILE
85

13.75
6.894

LAIapt SEL
0.35
0.00

13.75
1.977

LAIapt SEL
1.64
0.00

13.75
0.971

LAIapt SEL
2.19
0.00

DIFN
0.796

DIFN
0.289

DIFN
0.211

MTA
90

MTA
59

MTA
60

SEM SMP
0
1

SEM SMP
9
1

SEM SMP
9
1
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